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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Disclaimer for PDF Version of Online Help
This document is a PDF version of the online help. This PDF file is provided so you can easily print
multiple topics from the help information or read the online help in PDF format.

Note: Some topics do not convert properly to PDF, causing format problems. Some elements of
online help are completely removed from the PDF version. Those problem topics can be
successfully printed from within the online help.
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About This Guide
This guide is intended to help first-time users who purchased HP Data Protector Reporter to install
and configure the product quickly. If you aremigrating HP Data Protector Reporter, refer to theHP
Storage Essentials Installation Guide.
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Obtaining HP Data Protector Reporter
You can download HP Data Protector Reporter for a 60-day trial from
http://www.hp.com/go/storageessentials. Click TRIALS AND DEMOS > HP STORAGE
ESSENTIALS FOR DATA PROTECTOR REPORTER SOFTWARE FOR 60 DAYS. Then,
follow the prompts. If you do not have a Passport Account, follow the prompts to create one.
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Chapter 1

Installing HP Data Protector Reporter on
Microsoft Windows

Caution: HP Storage Essentials is designed for operation in a secure corporate intranet. All
other configurations are not recommended or supported.

The chapter contains the following topics:

l "Pre-installation Checklist" below

l "Installing the Product" on page 22

l "Removing the Product" on page 28

For information on how to install the product on Linux, see "Installing HP Data Protector Reporter
on Linux" on page 33.

Pre-installation Checklist
The following basic requirements must bemet before beginning an installation or migration:

l "Installation andMigration Requirements" below

l "Verify Networking" on page 21

l "Install a Supported Browser" on page 21

Installation and Migration Requirements
Verify that your environment meets or exceeds the requirements listed in the following table.

Note: You cannot proceed with your installation or migration until youmeet these
requirements.

Requirement Must Meet or Exceed

NTFS File System Installations: The NTFS file system is required to install the product.

Migrations (Contact Your Account Representative Before Migrating):
If Oracle is installed on a volume using the FAT32 file system, youmust
convert the volume to NTFS before you canmigrate. Contact customer
support for information about converting the volume to NTFS.
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Requirement Must Meet or Exceed

Screen Resolution Screen resolutions less than 800 pixels by 600 pixels will cause the
installation or migration to fail. The Install/Migrate wizard can run on a
screen resolution of 800 x 600 pixels, or higher, and can be resized.

Windows Account The account used to log onmust be in the Administrators group.

Operating System Refer to the support matrix.

Microsoft Internet
Explorer and
Firefox

Refer to the Browser tab in the support matrix.

TCP/IP TCP/IP must be enabled.

Minimum Disk
Space for the
Install/Migrate
Wizard

When the Install/Migrate wizard is running, it creates a temporary directory
named <system-drive:>\InstallSRMTemp that contains the files required
by the Install/Migrate wizard. This directory must have at least 2 GB of free
space.

Minimum
Recommended
Disk Space for the
Product

l Single Server = HP Storage Essentials, SRM Report Optimizer, and
Report Database installed on the same 64-bit server.
n With ARCHIVING and RMAN backup off: recommended disk space

300GB.

n With ARCHIVING and RMAN backup on: recommended disk space
450GB.

l Dual Server = HP Storage Essentials on oneWindows server and SRM
Report Optimizer\Report Database installed on a separateWindows
server.
n With ARCHIVING and RMAN backup off: recommended disk

space: 200GB.

n With ARCHIVING and RMAN backup on: recommended disk
space: 350GB.

Virtual Machines Installations on virtual machines are supported. Refer to the "Mgr
Platform" tab in the support matrix.

Required RAM Refer to the support matrix.

Required Ports Themanagement server requires certain ports be available. For more
information about the ports used, see "Ports Used by the Product" on page
33.

If you see a warning in the Ports Availability requirement, check tomake
sure that the ports listed are not currently in use andmake any changes
that are necessary. The installation will continue even if a required port is
not available.
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Requirement Must Meet or Exceed

Firewalls If themanagement server is behind a firewall, make sure that the ports
required by HP Data Protector Reporter are added to the firewall
“exceptions” list. This is required for Data Protector Reporter to
communicate with themanaged elements and enables a client web
browser to access HP Storage Essentials from outside the firewall.

DNS Resolution The Install/Migrate wizard verifies the IPv4 address and DNS name of the
server using nslookup. If nslookup is not successful, the installation will
not continue.

DNS Resolution failure prevents the product from running successfully. If
the DNS Resolution requirement fails, see "Troubleshooting Installation
andMigration" on page 117.

%perl5lib%
Environment
Variable

The%perl5lib% environment variable cannot be set to any value. For more
information, see "Troubleshooting Installation andMigration" on page 117.

Data Execution
Prevention (DEP)

Data Execution Prevention (DEP)must be set for "Essential Windows
Programs and Services Only." For information onmodifying the DEP
setting, see the documentation for yourWindows operating system.

The paths specified
in the Options tab
for the following
components share
these
requirements:

l HP Storage
Essentials

l Oracle
Database

l CIM extensions

l Reporter
Database

l Report
Optimizer

TheOptions tab has the following requirements for entering paths:

l Only the following characters are supported: A-z, 0-9, underscores,
periods, and backslashes.

l Paths cannot contain spaces.

l The drive letter must be a fixed drive.

Ports Used by the Product
HP Storage Essentials and Report Optimizer use a number of ports that cannot be used by another
program.
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Ports Used by the HP Storage Essentials

Port Description Protocol In/Out

22 Used by SSH to deploy host agents (optional –
only need if using the CIME Management tool)

SSH I/O1

80 Port used for discovery and the HTTP web
server.

l NetApp

l WebBrowser Interface

l HP Accelerator Pack for Operations
Orchestration

HTTP I/O1

161 l SNMP Agent

l Cisco SNMP

This port is not required and is optional for
SNMP trapping. HP Storage Essentials uses
SNMP version 2. Device alerts can also be
delivered to HP Storage Essentials via API or
SMI-S for certain devices.

SNMP I/O1

162 An external port that is used for the SNMP trap
listener. SNMP can be disabled, but no traps
will be received.

l Cisco SNMP

This port is not required, but it is optional for
SNMP trapping. HP Storage Essentials uses
SNMP version 2. Device alerts can also be
delivered to HP Storage Essentials via API or
SMI-S for certain devices.

SNMP I/O1

389

(TCP/UDP)

LDAP directory service

This port is required to communicate with the
Microsoft Exchange server. The port is used by
Active Directory and Active Directory Domain
Services.

LDAP O2
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Port Description Protocol In/Out

443 An external port used for Secure Socket Layer
(SSL) with the web interface. Port 80 can be
used instead, but there will be no SSL.

l Celerra

l HP Storage Essentials OM SPI

l NetApp

l VMWare VC/ESX

l WebBrowser interface

HTTPS I3

636

TCP

This port is required to communicate with the
Microsoft Exchange server. The port is used by
Active Directory and Active Directory Domain
Services.

LDAP/SSL O2

1099 l HP Storage Essentials Connector for HP
BSA Server Automation

l RMI Registry

l XP Arrays via Built-in XP Provider

TCP I3

1443 Microsoft SQL Server Database (optional – only
used if MSSQLDatabase Viewer is used)

O2

1521 l Oracle Transparent Name Substrate (TNS)
Listener Port (Used for reporter access to
HP Storage Essentials, as well as optional
Oracle Database Viewer discovery)

l HP uCMDB DDM Probe

TCP >I3

1972 Intersystems Caché Database JDBC O2

2001 Device discovery port for the following devices:

l XPs via CV-AE

l HDS via HDvM

HiCommand
API
(HTTP/HTTPS)

O2

2443 Device discovery port for the following devices:

l XPs via CV-AE

l HDS via HDvM

l VMWare VC/ESX

HiCommand
API
(HTTP/HTTPS)

>O2

2463 Device discovery port for the following devices:

l SUN through the Engenio/LSI provider

l Engenio/LSI based arrays

TCP O2
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Port Description Protocol In/Out

2707 Device discovery port for the EMC storage
systems discovered through Solutions
Enabler/SYMAPI

SYMAPI O2

3268

TCP

This port is required to communicate with the
Microsoft Exchange server.

The port is used by Active Directory and Active
Directory Domain Services. The Active
Directory global catalog listens on this port.

LDAP O2

3269

TCP

This port is required to communicate with the
Microsoft Exchange server.

The port is used by Active Directory and Active
Directory Domain Services. The
communications to the Active Directory global
catalog on this port are encrypted.

LDAP/SSL O2

4444 JBoss RMI/JRMP Invoker

HP Storage Essentials Connector for HP BSA
Server Automation

TCP I3

4445 JBoss Pooled Invoker TCP >L4

4673 l CIM Extension/Product Health Agent
(Tuneable)

l IBM VIO

TCP O2

5432 PostgreSQL Server Database JDBC O2

5555 Data Protector Agentless TCP O2

5962 Discovery Group 12 CIMOMRMI TCP >L4

5964 Discovery Group 11 CIMOMRMI TCP L4

5966 Discovery Group 10 CIMOMRMI TCP L4

5968 Discovery Group 9 CIMOMRMI TCP L4

5970 Discovery Group 8 CIMOMRMI TCP >L4

5972 Discovery Group 7 CIMOMRMI TCP L4

5974 Discovery Group 6 CIMOMRMI TCP L4

5976 Discovery Group 5 CIMOMRMI TCP L4

5978 Discovery Group 4 CIMOMRMI TCP >L4

5980 Discovery Group 3 CIMOMRMI TCP L4
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Port Description Protocol In/Out

5982 Discovery Group 2 CIMOMRMI TCP L4

5984 Discovery Group 1 CIMOMRMI TCP L4

5986 Default Discovery Group CIMOMRMI TCP >L4

5988/
5989

l 3PAR SMI-S

l Brocade SMI-A

l Cisco SMI-S

l Compellent SMI-S

l EVAs via CV-EVA SMI-S

l ESL/EML via CV-TL SMI-S v1.7/1.8/2.0

l ESL/EML via CV-TL SMI-S v2.2/2.3

l HP VLS 9000 (port 5988 only)

l HSG-80 via EML SMI-S

l IBM XIV

l McDATA SMI-S

l MSA 2300G2 viaMSA SMI-S Proxy
Provider

l MSA P2000G3 (port 5989 only)

l IBM CIM Agent

l QLogic SMI-S

l SMI-S and SMI-S secure

l WBEM/WMI Mapper

TCP/SMI-S O2

6389 Device discovery port for CLARiiON storage
systems discovered through the NaviSphere
CLI

Navisphere CLI O2

8009 JBoss Embedded Tomcat Service TCP L4

8083 JBoss Web Service L4

8093 JBoss UIL Server IL Service

HP Storage Essentials Connector for HP BSA
Server Automation

TCP I3

8443 BSAE DataMiner TCP O2

8873 BSAE DataMiner TCP O2
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Port Description Protocol In/Out

9088 IBM Informix Dynamic Server Database JDBC O2

12443 HP X9000. If the default port does not work,
specify the port that is used, such as port 443.

HTTPS O2

16022 Lefthand Network SSH O2

49152 WBEM TCP SMI-S O2

49153 WBEM Secure Port TCP SMI-S >O2

50000 IBM DB2Database JDBC O2

55988 WBEM TCP SMI-S O2

55989 WBEM Secure Port TCP SMI-S O2

60000 WBEM TCP SMI-S >O2

60001 WBEM Secure Port TCP SMI-S O2

Legend
1 I/O = The port numbermust be opened on both HP Storage Essentials server and

target device.

2 O= The port numbermust be opened on the target device.

3 I = The port numbermust be opened on the Source Server; for example, the HP
Storage Essentials management server, the Report Optimizer server, or the SMI
Agent (to receive information from a switch).

4 L = A loopback port that must be available to the source server but not exposed
outside.

Ports Used by Report Optimizer

Port Description

2638 SQL Anywhere for the Report Optimizer database uses this port.

6400, 6410, 6420, and 80 SI Agent uses these ports.

8080, 8005, 8443 Tomcat uses these ports.

Turn Off Internet Information Services (IIS) and
Third-Party Web Servers

To turn off Internet Information Services (IIS) and third-party Web servers, verify that Internet
Information Services (IIS) is either not installed or the service is set to manual and stopped.

HP Data Protector Reporter (9.6.0)Page 20 of 143



Quick Start Guide
Chapter 1: Installing HP Data Protector Reporter onMicrosoft Windows

Disable User Access Control on Windows
Do one of the following:

l Windows 2008 SP1 and SP2. Disable user access control (UAC).

l Windows 2008 R2. Set UAC to the lowest level available.

For more information on how to change your settings for UAC, see theMicrosoft Windows
documentation for your operating system.

Verify Networking
Themanagement server must have static or dynamic host name resolution.

To verify that the server’s name can be resolved through DNS on aWindows server 2008:

1. Right-click My Computer in the Start menu.

2. Select Properties. The Full computer name appears on the System page under Computer
name, domain, and workgroup settings. The server must be in the domain in which it is going to
be used.

3. From a command prompt, type nslookup <FQDN>. FQDN (fully qualified domain name) is
the fully qualified computer name obtained in the previous step.

4. In the command prompt, type nslookup <IP address>. IP address is the IP address of
the server.
Both results from nslookup should have the same fully qualified computer name and IP
address.

5. In the command prompt, type nslookup <Short name of computer>. Results should
resolve to the computer’s fully qualified computer name and IP address.

Themanagement server uses nslookup to resolve the names and IP addresses of managed
systems. If the DNS suffix com is listed in the TCP/IP properties as one to append, problems such
as inaccurate system status and incorrect IP addresses for systems HP Storage Essentials
manages might occur. To correct this, remove com from the TCP/IP DNS suffix list:

1. OpenControl Panel > Network and Internet > Network and Sharing Center > Manage
Network Connections.

2. Right-click Local Area Connection and select Internet Protocol > Properties > Advanced
> DNS tab.

3. If com is in theAppend these suffixes (in order) box, remove it.

Caution: If you plan to browse to HP Storage Essentials from a server in a different domain,
verify that the DNS suffix of themanagement server is added to the suffix list of the web client.

Install a Supported Browser
Install a supported browser on any machine from which you intend to view HP Storage Essentials
pages. See the support matrix for your edition for a list of supported browsers.
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Installing the Product
Caution: Do not manually install the Oracle database using the Oracle DVD set. The HP
Storage Essentials Install/Migrate wizard prompts you for the Oracle installation files when the
Oracle installation components are required.

This section contains the following information:

l "Windows Installation Checklist" below

l "Step 1 – Read the Release Notes and the Support Matrix" on the next page

l "Step 2 – LogOn to theWindows Server" on the next page

l "Step 3 –Open Several Ports (Windows 2008 R2Only)" on the next page

l "Step 4 – Start the HP Storage Essentials forWindows InstallationWizard" on page 24

l "Step 5 –Obtain a License Key" on page 27

l "Step 6 – Check for the Latest Service Pack" on page 28

Windows Installation Checklist
Print the following table and use it to track your progress. Each time you complete a step, check off
the step in the "Did You Complete This Step?" column.

Step Need More information?

Did You
Complete This
Step?

Read the Support Matrix and
Release Notes.

"Step 1 – Read the Release Notes
and the Support Matrix" on the next
page

Logon to theWindows Server. "Step 2 – LogOn to theWindows
Server" on the next page

Open Several Ports (Windows 2008
R2Only)

"Step 3 –Open Several Ports
(Windows 2008 R2Only)" on the
next page

Start the HP Storage Essentials for
Windows InstallationWizard.

"Step 4 – Start the HP Storage
Essentials forWindows Installation
Wizard" on page 24

Obtain a License Key. "Step 5 –Obtain a License Key" on
page 27

Check for the Latest Service Pack. "Step 6 – Check for the Latest
Service Pack" on page 28

Windows Installation Checklist
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Step 1 – Read the Release Notes and the Support
Matrix

TheRelease Notes discuss late-breaking issues not covered in the Installation Guide. Read the
support matrix to make sure the server on which you plan to install themanagement server meets
or exceeds the requirements. Management server requirements are listed on theManager Platform
(Mgr Platform) tab of the support matrix. TheRelease Notes and support matrix can be found in any
of the top-level directories of theHP_SE_9.6.0DVD.

If you run the installer on an unsupported operating system, the following error message is
displayed:

This system type is not supported, please check the support matrix for

supported type.

Step 2 – Log On to the Windows Server
Create a new account or log on to an existing account on theWindows system onwhich you are
installing HP Storage Essentials. The new account or the existing account you usemust be a
member of the Administrators group. Before installing, youmust disable UAC as described in
"Disable User Access Control onWindows" on page 21.

Step 3 – Open Several Ports (Windows 2008 R2
Only)

If you plan to install HP Data Protector Reporter onWindows 2008 R2, youmust open several ports
before you begin the installation.

For example, to open ports 6400 and 8080, complete the following steps:

1. OpenWindows Firewall with Advanced Security by selectingStart > Administrative Tools >
Windows Firewall Advanced Security.

2. Create a new Inbound Rule, as follows:

a. Click Inbound Rules.

b. Select New Rule from the right-click menu.

3. Select thePort option and click Next.

4. Select the TCP option.

5. Enter 6400, 8080 for specific local ports. Make sure there is a space between the comma
and 8080.

6. Click Next.

7. Select theAllow the connection option and then click Next.

8. In theWhen does this rule apply? window, select theDomain, Private, andPublic options.

9. Click Next.

10. Type a name for the rule; for example, Reporter ports.
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11. Click Finish.

12. Refer to the next section for information about the installation. During the installation you are
shownWindows Security Alerts. Keep the defaults in theWindows Security Alerts and always
click Allow Access.

Step 4 – Start the HP Storage Essentials for
Windows Installation Wizard

Keep inmind the following:

l Before you start the installation wizard, make sure all applications are closed. If the wizard
detects locked files, the installation stops and a link to a log file is provided. This log file contains
the details on the files that are locked. Youmust unlock these files by closing the corresponding
application, and resume the installation process. If the log file contains a lockedmessage for the
explorer.exe process, youmust reboot the server and restart the installation process.

l For amanagement server configured on dual-stack IPv6 network, make sure that the IPv4 and
IPv6 address is mapped to the same host name or canonical name in the server hosts file. If the
IPv4 and IPv6 addresses aremapped to a different host name or canonical name, a connection
cannot be established between HP Data Protector Reporter and Report Optimizer.
For example, if themanagement server is configured on a dual-stack IPv6 network, the server
hosts file must contain the following entries:
192.168.0.0 node1.foo.com node1

fc00:0db8::ff00:ac10:be01 node1.foo.com node1

To install the product:

1. Verify the following:

n The designated HP Storage Essentials server meets or exceeds the requirements listed in
the "Pre-installation Checklist" on page 13 and in the support matrix.

n The file system format on the HP Storage Essentials server is NTFS. The HP Storage
Essentials installation wizard will display an error message if the file system is not NTFS.

The directory in which you install themanagement server must have write access for the
local Administrators group. Installing themanagement server in a directory created by
another program— for example, the Proliant Support Pack — is not recommended.

2. Log on as a user that is amember of the Administrators group.

3. Do one of the following:

The installation bits must be local. Youmust either insert the DVD locally or copy the bits to
the server where you are planning to install the product.

n DVD. Insert theHP_SE_9.6.0DVD in the designated HP Storage Essentials server.

Or

n Copied locally. Copy the bits of theHP_SE_9.6.0DVD to the server where you are
planning to install the product. Make sure that the directory path where you copy the
installationmedia does not contain spaces or special character. The installation fails with
themessage "The system cannot find the path specified" if space or special
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characters are used.

If you copy the Oracle DVD, copy it to a top-level directory where the directory path is not
more than 20 characters long.

When you copy the bits from aDVD to the server, preserve directory names and structures.
The directory structure you copiedmust match the folder structure exactly.

4. In the root directory of the installationmedia, double-click setup.exe in the
ManagerCDWindows directory on the DVD. The HP Storage Essentials forWindows installer
starts, and theWelcome page is displayed. Make sure that you have downloaded the latest
Service Packs and read the product documentation before starting the installation process.

5. Click Next. The System Scan page appears. The installation wizard scans the computer to
ensure that the server is ready for installation. If the wizard detects that one or more
prerequisites are not met, the scan process is halted. The Scan Report dialog box appears that
provides details on the action that youmust complete before proceeding with the installation.
After you take the required action, click Re-Scan to restart the scan process. The scan
process is successful when the progress bar shows 100%.

6. Click Next to continue with the installation.

7. On the Select Product page, select HP Data Protector Reporter option.

Refer to the online help in the wizard for more information about each product.

8. Click Next. On the Installation Options page, provide the location where the product must be
installed. The default installation location is C:\HP. You can accept the default location, or
click Browse to select a different location. You can also select the default location by clicking
theRestore Default Folder button.

9. TheOptions page displays the components that will be installed. The options are selected by
default because you previously selected the HP Data Protector Reporter option. Reporter and
themanagement server are automatically installed on the same server as part of the
configuration for HP Data Protector Reporter:

n Management Server: If you selected HP Data Protector Reporter, this option is selected
by default.

n Reporter: If you selected HP Data Protector Reporter, this option is selected by default.
You can optionally specify the installationmedia path for Reporter in theMedia Path
(Optional) field. The installer automatically looks in the location specified and you will not
need to swap out the DVD for Reporter. You can also provide the drive location if the
installation files were copied locally.

10. Under Oracle section, provide the installation location for the Oracle database. The default
installation location is C:\oracle. You can accept the default location, or click Browse to
select a different location. You can also select the default location by clicking theRestore
Default Folder button.

11. (Optional): You can optionally specify the installationmedia path for Oracle in theMedia Path
(Optional) field. The installer automatically looks in the location specified and you will not need
to swap out the DVD for Oracle. You can also provide the path if the files were copied locally.

12. Click Next. On the Password page, type the password in thePassword field. This password is
used for the Data Protector Reporter Admin, Data Protector Reporter database user (appiq_
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system), Report Optimizer Administrator, and Report Database user (appiq_system). Re-
enter the password in the Confirm Password field. Although the installer allows you to save the
passwordmultiple times, note that HP Data Protector Reporter will remember the last saved
password only. Click Next. Note that the installer remembers the password even if you
navigate using the Back button.

Note: The password policy enforces a few restrictions that do not allow you to enter some
characters using the Install/Migrate wizard. An administrator can however change the
password after the installation is complete. See the following sections for more details on
how to change the passwords:

n To change Data Protector Reporter Admin and Data Protector Reporter database user
password using the Database Admin utility, see the sections Changing System
Account Passwords andChanging the Admin Password for theManagement Server in
the chapterDatabaseMaintenance andManagement of theHP Data Protector
Reporter User Guide.

n To change Report Optimizer Administrator password, see "Changing the Passwords
for Report Optimizer Accounts" on page 59

n To change the Report Database user password, see the sectionChanging the DB_
SYSTEM_USER Password in theHP Data Protector Reporter Report Database
Guide.

13. Review the list of requirements on the Verify System Requirements page to know if the server
meets the requirements. The following table summarizes what each icon on the Verify page
depicts:

Icon Meaning

The server meets installation requirements.

Setting barely meets installation requirements. The installation will proceed but there
might be some issues. It is highly recommended you change the setting.

Setting does not meet the installation requirements. Even though the installation will
still proceed, the product might not work as expected after the installation. Resolve
the issue before proceeding with the installation.

14. Click Next. The Pre-Installation Summary page displays the components to be installed and an
estimate of the time in hours:minutes:seconds it will take to complete installing each
component.

15. Click Install to start the installation. The Progress page provides a status of the installation for
each component. You are asked to provide the Oracle installationmedia location, if you did not
provide that in the Options page. If during installation, an error is observed, the installation
stops and the Resume button is enabled. You are also provided with a link to the error log file.
This error log file provides you the details of the error that occurred during the installation. You
must fix the error and then click Resume button to continue the installation.
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Note: If you are shown a command line window for the Oracle Universal Installer, do not
close this window.

16. After the installation is complete, the progress bar on the Progress page shows 100%. Click
Next to finish the installation process.

17. On the Installation Complete page, copy the Unique Client ID number, and select one of the
following options. The Unique Client ID number is required to obtain the license.

n Start HP Data Protector Reporter When "Finish" is Clicked. This option starts the
AppStorManager service after you click Finish. You can then access themanagement
server. Note that the AppStorManager servicemight take a few minutes to start.

n Start HP Data Protector Reporter later. This option requires you to start the
AppStorManager service at a later time, either manually or by rebooting the server. Users will
not be able to access themanagement server unless the AppStorManager service is running.

18. For details about accessing the HP Storage Essentials installation log files, see "Log Files
from the Installation andMigration onWindows" on page 118.

Step 5 – Obtain a License Key
See your product invoice for important information about licensing. If you are required to import a
license, copy your Unique Client ID (UID) number and follow the instructions in your product
invoice documentation to obtain and apply your license key. A valid license key is required to use
themanagement server and to collect data from amanaged element.

Verify that the following are enabled on your web browser:

l Cookies

l JavaScript

l Java

Additionally, make sure that the AppStorManager service is running. This servicemust be running
for the product to work.

To obtain your HP Storage Essentials license, youmust have the UID. This ID is displayed in the
Installation Complete page of the HP Data Protector Reporter Install/MigrateWizard. If you did not
copy the Unique Client ID during installation, you can obtain the Unique Client ID after you log on
for the first time to HP Storage Essentials.

To obtain the UID from themanagement server, complete the following steps:

1. Log on to themanagement server.
a. Open a web browser and enter the URL of the server running themanagement server; for

example, http://www.myserver.com.

b. Type admin for the user name and the password that you provided in the Password page
of the Install/Migrate wizard, during the product installation.

2. Select Security > Licenses in themanagement server.

3. At the top of the page, select the unique client ID and press CTRL + C to copy it.

Follow these steps to obtain and import your HP Storage Essentials license:
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1. Go to http://h30580.www3.hp.com/poeticWeb/portalintegration/hppWelcome.htm and select
theGenerate New Licenses option. Follow the steps for obtaining your license key. You will
need to provide your UID and HP Order ID (found on the entitlement certificate).

2. After you obtain your license, log on to themanagement server.
a. Open a web browser and enter the URL of the server running themanagement server; for

example, http://www.myserver.com.

b. Type admin for the user name and the password that you provided in the Password page
of the Install/Migrate wizard, during the product installation.

3. Import the license key:

a. Click theSecuritymenu.

b. Click Licenses from themenu.

c. Click the Import License File button.

d. Click theBrowse button. The file system of the computer used to access themanagement
server is shown.

e. Select the license file.

f. Click OK.

Step 6 – Check for the Latest Service Pack
A service pack might have been created since this release. Obtain the latest service pack from the
following location:

http://h20230.www2.hp.com/selfsolve/patches

Removing the Product
HP Storage Essentials provides scripts to remove themanagement server, Reporter and the
Oracle database. Run these scripts if you want to remove themanagement server and Reporter
(Report Optimizer and the Report Database). If themanagement server and Reporter are on
separate servers, run the scripts on each server.

Use the uninstall scripts instead of Add/Remove programs. If you try Add/Remove programs, the
followingmessage appears, and you are prompted to use the uninstall scripts:

HP Storage Essentials must be uninstalled using uninstall scripts in

the ManagerCDWindows\install\support folder of Product ISO CD

The uninstall scripts stops all Java processes. Other applications on the server running java.exe
are stopped during the uninstall of HP Storage Essentials. After reboot, all processes continue as
normal.

To uninstall the product fromWindows:

1. Insert theHP_SE_9.6.0DVD to the server that has themanagement server installed. Open a
command prompt window and navigate to the following directory:
ManagerCDWindows\install\support
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2. Type the following command at the command prompt:

removeAll.cmd

The removeAll.cmd script removes the following components from the server:

n Themanagement server

n The database instance for themanagement server

n The Report Database

n Report Optimizer

n The database instance for Reporter

n The CIM extension installation files

Note: During the uninstall process, youmight observe that the uninstall does not
proceed further and stops at the followingmessage:

cmd.exe /c "msiexec /x {5418F914-1D31-4849-822C-314AC28B06BF}

/qn /l*vC:\srmInstallLogs\BOEXIR31uninstall.log

REBOOT=ReallySuppress

If this message appears for the time duration ranging from a couple of minutes to a
couple of hours, youmust restart your computer and then run the removeAll.cmd
again.

3. Type the following command to remove theOracle software:

RemoveOracle.cmd

4. Reboot the Server. This step is required to finish the cleanup of the files.

Log Files from the Installation and Migration
on Windows

The Install/Migrate wizard generates log files in the C:\srmInstallLogs directory. Log files
provided at the top level of the C:\srmInstallLogs directory are for the current session of the
Install/Migrate wizard or for the last session the Install/Migrate wizard was run. Files from a
previous session are stored in a subdirectory with a date and time stamp.

Log files are generated by the Install/Migrate wizard. Some log files also provide an <logfilename>_
output.log file. The <logfilename>_output.log file displays information about any errors, and is
generated by the component itself instead of the Install/Migrate wizard.

The log files are zipped into a file in the root of the system drive. The zip file can be sent to support
to help diagnose installation andmigration issues, for example: C:\srmLog02-01-2011-16_
21_49.zip.

The following log files can be found in C:\srmInstallLogs:

l Srm_InstallBaseSoftware_Output.log provides logging information about the installation of
the base version of HP Storage Essentials.
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l Srm_DatabaseInstance_Output.log provides information about any errors that occurred during
the creation of the database instance for HP Storage Essentials.

l Srm_CopyCimExtensions_Output.log provides logging information about the copying of the
CIM extensions. This log file is only provided if you select the option to copy the CIM extensions
to themanagement server during the installation or migration.

l Srm_ImportDatabase_Output.log provides logging information about the database import
process when you run the Install/Migrate wizard tomigrate to the latest HP Data Protector
Reporter environment. This log file is provided only if you aremigrating HP Data Protector
Reporter.

l Srm_ExportDatabase_Output.log provides logging information about the database export
process when you run the Install/Migrate wizard to back up the database. The database backup
is required when you aremigrating HP Data Protector Reporter. This log file is provided only if
you aremigrating HP Data Protector Reporter.

l Srm_RestoreConfiguration_Output.log provides logging information about the restore
process when you aremigrating HP Data Protector Reporter.

l backUpConfiguration.log provides the logging information about the back up process that
occurs when you aremigrating HP Storage Essentials.

l Ro_InstallBaseSoftware_Output.log provides logging information about the installation of the
base version of Report Optimizer.

l Ro_InstallROSoftware_Output.log provides logging information about the installation and
migration of Report Optimizer.

l Ro_UpgradeTomcat_Output.log provides logging information about the Tomcat upgrade
process during the installation andmigration of the Report Optimizer.

l Ro_ImportBiarFile_Output.log provides logging information about the import of the BIAR file
during the installation andmigration of the Report Optimizer.

l Ro_ImportPreviousBiarFile_Output.log provides logging information about the import of the
BIAR file when you run the Install/Migrate wizard tomigrate to the new version of the Report
Optimizer.

l Ro_ExportBiarFile_Output.log provides logging information about the export of the BIAR file
when you run the Install/Migrate wizard to export the Report Optimizer configuration.

l Rd_InstallBaseSoftware_Output.log provides logging information about the installation of the
base version of the Report Database.

l Rd_InstallDatabase_Output.log provides logging information about the creation of the
database instance for the Report Database.

l Rd_Resetpassword_Output.log provides logging information about the password reset
operation for Report Database user. This log file is available only if you have installed Report
Optimizer.

l Oracle_InstallBaseSoftware.log provides logging information about the installation of the base
version of the Oracle database.

l Oracle_InterimPatches.log provides logging information about the installation of the patches
for the Oracle database.
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l Wizard.log is themaster log file of the Install/Migrate wizard session. It provides information for
troubleshooting installation of themanagement server and related components.

l WizardSetup.log is the log file of the installation wizard entry point. It provides information for
troubleshooting installation wizard startup issues. The log file without a date and time is the
current log file. This file provides information of the last task that was done in the installation
wizard.

l Srmwiz.ini provides information about the settings for the Install/Migrate wizard, such as the
installation directory for HP Storage Essentials.

About This Guide
This guide is intended to help first-time users who purchased HP Data Protector Reporter to install
and configure the product quickly. If you aremigrating HP Data Protector Reporter, refer to theHP
Storage Essentials Installation Guide.
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Chapter 2

Installing HP Data Protector Reporter on
Linux

Note: HP Storage Essentials is designed for operation in a secure corporate intranet. All other
configurations are not recommended or supported.

If you are installing themanagement server onWindows, see "Installing HP Data Protector
Reporter onMicrosoft Windows" on page 13.

This section includes the following installation topics and steps:

l "Pre-installation Checklist" below

l "Linux Installation Checklist" on page 44

l "Step 1 – Read the Release Notes and the Support Matrix" on page 45

l "Step 2 – Install theManagement Server" on page 45

l "Step 3 – Verify that Processes Can Start" on page 52

l "Step 4 –Obtain a License Key" on page 52

l "Step 5 – Verify Your Connection to theManagement Server" on page 53

l "Step 6 – Check for the Latest Service Pack" on page 55

l "Step 7 – Install the Java Plug-in on a Linux Client" on page 55

l "Log Files from the Installation on Linux" on page 120

l "Removing HP Data Protector Reporter" on page 57

Pre-installation Checklist
Security-Enhanced Linux (SELinux) must be disabled on the server where HP Storage Essentials
is to be installed. SELinux must be kept disabled forever, that is, before and after the installation.

Refer to the support matrix for your edition for memory requirements. The installation will stop if the
server does not meet thememory requirements.

Ports Used by the Product
HP Storage Essentials and Report Optimizer use a number of ports that cannot be used by another
program.
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Ports Used by the HP Storage Essentials

Port Description Protocol In/Out

22 Used by SSH to deploy host agents (optional –
only need if using the CIME Management tool)

SSH I/O1

80 Port used for discovery and the HTTP web
server.

l NetApp

l WebBrowser Interface

l HP Accelerator Pack for Operations
Orchestration

HTTP I/O1

161 l SNMP Agent

l Cisco SNMP

This port is not required and is optional for
SNMP trapping. HP Storage Essentials uses
SNMP version 2. Device alerts can also be
delivered to HP Storage Essentials via API or
SMI-S for certain devices.

SNMP I/O1

162 An external port that is used for the SNMP trap
listener. SNMP can be disabled, but no traps
will be received.

l Cisco SNMP

This port is not required, but it is optional for
SNMP trapping. HP Storage Essentials uses
SNMP version 2. Device alerts can also be
delivered to HP Storage Essentials via API or
SMI-S for certain devices.

SNMP I/O1

389

(TCP/UDP)

LDAP directory service

This port is required to communicate with the
Microsoft Exchange server. The port is used by
Active Directory and Active Directory Domain
Services.

LDAP O2
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Port Description Protocol In/Out

443 An external port used for Secure Socket Layer
(SSL) with the web interface. Port 80 can be
used instead, but there will be no SSL.

l Celerra

l HP Storage Essentials OM SPI

l NetApp

l VMWare VC/ESX

l WebBrowser interface

HTTPS I3

636

TCP

This port is required to communicate with the
Microsoft Exchange server. The port is used by
Active Directory and Active Directory Domain
Services.

LDAP/SSL O2

1099 l HP Storage Essentials Connector for HP
BSA Server Automation

l RMI Registry

l XP Arrays via Built-in XP Provider

TCP I3

1443 Microsoft SQL Server Database (optional – only
used if MSSQLDatabase Viewer is used)

O2

1521 l Oracle Transparent Name Substrate (TNS)
Listener Port (Used for reporter access to
HP Storage Essentials, as well as optional
Oracle Database Viewer discovery)

l HP uCMDB DDM Probe

TCP >I3

1972 Intersystems Caché Database JDBC O2

2001 Device discovery port for the following devices:

l XPs via CV-AE

l HDS via HDvM

HiCommand
API
(HTTP/HTTPS)

O2

2443 Device discovery port for the following devices:

l XPs via CV-AE

l HDS via HDvM

l VMWare VC/ESX

HiCommand
API
(HTTP/HTTPS)

>O2

2463 Device discovery port for the following devices:

l SUN through the Engenio/LSI provider

l Engenio/LSI based arrays

TCP O2
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Port Description Protocol In/Out

2707 Device discovery port for the EMC storage
systems discovered through Solutions
Enabler/SYMAPI

SYMAPI O2

3268

TCP

This port is required to communicate with the
Microsoft Exchange server.

The port is used by Active Directory and Active
Directory Domain Services. The Active
Directory global catalog listens on this port.

LDAP O2

3269

TCP

This port is required to communicate with the
Microsoft Exchange server.

The port is used by Active Directory and Active
Directory Domain Services. The
communications to the Active Directory global
catalog on this port are encrypted.

LDAP/SSL O2

4444 JBoss RMI/JRMP Invoker

HP Storage Essentials Connector for HP BSA
Server Automation

TCP I3

4445 JBoss Pooled Invoker TCP >L4

4673 l CIM Extension/Product Health Agent
(Tuneable)

l IBM VIO

TCP O2

5432 PostgreSQL Server Database JDBC O2

5555 Data Protector Agentless TCP O2

5962 Discovery Group 12 CIMOMRMI TCP >L4

5964 Discovery Group 11 CIMOMRMI TCP L4

5966 Discovery Group 10 CIMOMRMI TCP L4

5968 Discovery Group 9 CIMOMRMI TCP L4

5970 Discovery Group 8 CIMOMRMI TCP >L4

5972 Discovery Group 7 CIMOMRMI TCP L4

5974 Discovery Group 6 CIMOMRMI TCP L4

5976 Discovery Group 5 CIMOMRMI TCP L4

5978 Discovery Group 4 CIMOMRMI TCP >L4

5980 Discovery Group 3 CIMOMRMI TCP L4
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Port Description Protocol In/Out

5982 Discovery Group 2 CIMOMRMI TCP L4

5984 Discovery Group 1 CIMOMRMI TCP L4

5986 Default Discovery Group CIMOMRMI TCP >L4

5988/
5989

l 3PAR SMI-S

l Brocade SMI-A

l Cisco SMI-S

l Compellent SMI-S

l EVAs via CV-EVA SMI-S

l ESL/EML via CV-TL SMI-S v1.7/1.8/2.0

l ESL/EML via CV-TL SMI-S v2.2/2.3

l HP VLS 9000 (port 5988 only)

l HSG-80 via EML SMI-S

l IBM XIV

l McDATA SMI-S

l MSA 2300G2 viaMSA SMI-S Proxy
Provider

l MSA P2000G3 (port 5989 only)

l IBM CIM Agent

l QLogic SMI-S

l SMI-S and SMI-S secure

l WBEM/WMI Mapper

TCP/SMI-S O2

6389 Device discovery port for CLARiiON storage
systems discovered through the NaviSphere
CLI

Navisphere CLI O2

8009 JBoss Embedded Tomcat Service TCP L4

8083 JBoss Web Service L4

8093 JBoss UIL Server IL Service

HP Storage Essentials Connector for HP BSA
Server Automation

TCP I3

8443 BSAE DataMiner TCP O2

8873 BSAE DataMiner TCP O2
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Port Description Protocol In/Out

9088 IBM Informix Dynamic Server Database JDBC O2

12443 HP X9000. If the default port does not work,
specify the port that is used, such as port 443.

HTTPS O2

16022 Lefthand Network SSH O2

49152 WBEM TCP SMI-S O2

49153 WBEM Secure Port TCP SMI-S >O2

50000 IBM DB2Database JDBC O2

55988 WBEM TCP SMI-S O2

55989 WBEM Secure Port TCP SMI-S O2

60000 WBEM TCP SMI-S >O2

60001 WBEM Secure Port TCP SMI-S O2

Legend
1 I/O = The port numbermust be opened on both HP Storage Essentials server and

target device.

2 O= The port numbermust be opened on the target device.

3 I = The port numbermust be opened on the Source Server; for example, the HP
Storage Essentials management server, the Report Optimizer server, or the SMI
Agent (to receive information from a switch).

4 L = A loopback port that must be available to the source server but not exposed
outside.

Ports Used by Report Optimizer

Port Description

2638 SQL Anywhere for the Report Optimizer database uses this port.

6400, 6410, 6420, and 80 SI Agent uses these ports.

8080, 8005, 8443 Tomcat uses these ports.

Prerequisite RPMs
Verify that your system includes the required packages by using the following command:

rpm –q <package-name>

Example

rpm -q binutils
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The above command checks for the availability of binutils package in your system and if
available, lists the version of the package.

Ensure that the installed version of the package is equal to or later than the listed versions of the
packagementioned below.

If the package is not installed, install the required packages from the DVD for your operating
system. If the version of the installed package is an older version, contact your system
administrator and upgrade it.

Note: The following sections provide the list of required RPMs. Based on themode selected
during the installation of the operating system, youmight be required to install the dependent
RPMs also.

For reference, see the Appendix "Required and Dependent RPMs list for Default Operating
System Installation" on page 1 to view the complete list of required and dependent RPMs for
default operating system installation.

Install the following RPMs on your system:

l "Prerequisite RPMs for Database Admin Utility" below

l "Prerequisite RPMs for Oracle" below

l "Prerequisite RPMs for Report Optimizer" on page 42

Some of these packages might be selectively installed depending on themode selected during an
installation of the operating system.

Prerequisite RPMs for Database Admin Utility
The following list includes the packages needed for the Database Admin Utility installation on
RHEL 6.3:

l libXrender-0.9.5 (32-bit)

l libXext-1.1-3 (32-bit)

l libXtst-1.0.99.2-3 (32-bit)

Prerequisite RPMs for Oracle
The following list includes the packages needed for the Oracle installation.

RHEL 5.9 (64-bit)

Install the following packages or later versions for RHEL 5.9 systems (64-bit):
All packages listed are 64-bit unless otherwise stated.

l binutils-2.17.50.0.6

l compat-libstdc++-33-3.2.3

l compat-libstdc++-33-3.2.3(32-bit)

l elfutils-libelf-0.125
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l elfutils-libelf-devel-0.125

l gcc-4.1.2

l gcc-c++-4.1.2

l glibc-2.5-24

l glibc-2.5-24(32-bit)

l glibc-common-2.5

l glibc-devel-2.5

l glibc-devel-2.5(32-bit)

l glibc-headers-2.5

l ksh-20060214

l libaio-0.3.106

l libaio-0.3.106(32-bit)

l libaio-devel-0.3.106

l libaio-devel-0.3.106(32-bit)

l libgcc-4.1.2

l libgcc-4.1.2(32-bit)

l libstdc++-4.1.2

l libstdc++-4.1.2(32-bit)

l libstdc++-devel-4.1.2

l redhat-lsb-3.1

l make-3.81

l numactl-devel-0.9.8

l sysstat-7.0.2

l unixODBC-2.2.11

l unixODBC-2.2.11(32-bit)

l unixODBC-devel-2.2.11

l unixODBC-devel-2.2.11(32-bit)

RHEL 6.3 (64-bit)

Install the following packages or later versions for RHEL 6.3 systems (64-bit):
All packages listed are 64-bit unless otherwise stated.

l binutils -2.20.51.0.2

l compat-libcap1- 1.10

l compat-libstdc++-33-3.2.3

l compat-libstdc++-33-3.2.3(32-bit)
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l gcc -4.4.6

l gcc-c++-4.4.6

l glibc-2.12-1

l glibc-2.12-1(32-bit)

l glibc-common-2.12

l glibc-devel-2.12

l glibc-devel-2.12(32-bit)

l ksh-20100621

l libaio-0.3.107

l libaio-0.3.107(32-bit)

l libaio-devel-0.3.107

l libaio-devel-0.3.107(32-bit)

l libgcc-4.4.6

l libgcc-4.4.6(32-bit)

l libstdc++-4.4.6

l libstdc++-4.4.6(32-bit)

l libstdc++-devel-4.4.6

l make-3.81

l sysstat-9.0.4

l unixODBC-2.2.14

l unixODBC-2.2.14(32-bit)

l unixODBC-devel-2.2.14

l unixODBC-devel-2.2.14(32-bit)

SUSE 11 (64-bit)

Install the following packages or later versions for SUSE 11 (64-bit):
All packages listed are 64-bit unless otherwise stated.

l binutils-2.19

l gcc-4.3

l gcc-32bit-4.3

l gcc-c++-4.3

l glibc-2.9

l glibc-32bit-2.9

l glibc-devel-2.9

l glibc-devel-32bit-2.9
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l ksh-93t-9.4

l libaio-0.3.104

l libaio-32bit-0.3.104

l libaio-devel-0.3.104

l libaio-devel-32bit-0.3.104

l libgcc43-4.3.3*

l libstdc++33-3.3.3

l libstdc++33-32bit-3.3.3

l libstdc++43-4.3.3*

l libstdc++43-32bit-4.3.3*

l libstdc++43-devel-4.3.3*

l libstdc++43-devel-32bit-4.3.3*

l libstdc++-devel-4.3

l make-3.81

l orarun-1.9-172

l sysstat-8.1.5

l unixODBC-2.2.12

l unixODBC-devel-2.2.12

l unixODBC-32bit-2.2.12

Prerequisite RPMs for Report Optimizer
The following list includes the packages needed for the Report Optimizer installation on RHEL 6.3:

All packages listed are 64-bit unless otherwise stated.

l libXext-1.1-3 (32-bit)

l libXext-devel-1.1-3

l libXext-devel-1.1-3 (32-bit)

l compat-libstdc++-33-3.2.3 (32-bit)

l glibc-2.12-1

l ncurses-libs-5.7-3 (32-bit)

Software Dependencies
Verify that the following required software is available on your system, and install any that are
missing:
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l Perl 5.8.3 or above. By default, the operating system installs Perl as follows:
n RedHat Linux (RHEL) 5.9 installs Perl 5.8.8

n RedHat Linux (RHEL) 6.3 installs Perl 5.10.1

n SUSE Linux Enterprise 11 installs Perl 5.10.0

Application Viewer requires Xvfb.

l For RHEL 5.9, the package name is xorg-x11-server-Xvfb-1.10.6-1.el6.x86_64.rpm.

Note: The Xvfb RPM is not required on RHEL 6.3.

l For SUSE Linux Enterprise 11, the package name is xorg-x11-server-extra.

The respective Xvfb package is available on the installationmedia of your operating system.

Verify Network Settings
Verify the network configuration for themanagement server:

1. Verify that the appropriate DNS server entries are present in /etc/resolv.conf. Verify that
the correct DNS suffixes arementioned in the order of preference in which they need to be
appended to hostnames; for example:

nameserver 172.168.10.1

nameserver 172.168.10.2

search “yourenvironment”.com

Note: If DNS is not configured in your environment, ignore this step.

2. From a console window on themanagement server, enter the following command:

# ping <hostname>

In this instance, <hostname> is the hostname (without domain name) of the Linux CMS.

The ping commandmust ping the IP address of themanagement server. It must not ping the
loopback address (127.0.0.1). If it pings the loopback address, edit the /etc/hosts file to
make appropriate corrections.

The /etc/hosts file should have entries similar to:

127.0.0.1 localhost.localdomain localhost

192.168.0.100 myservername.mydomain.com myservername

Note: If DNS is not configured in your environment, the /etc/hosts file should have entries
similar to:
127.0.0.1 localhost.localdomain localhost

192.168.0.100 myservername
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If the ping command fails to ping the IP address and instead pings the loopback address, the
oracle listener process will fail to start and, therefore, the CIMOM process will also fail.

SUSE Linux Enterprise 11might have an entry for 127.0.0.2 in /etc/hosts against the host
name for that system. Comment out or remove the line that maps the IP address 127.0.0.2 to
the system's fully qualified hostname. Retain only that line that contains the actual IP address
mapped to the fully qualified host name; for example:

# cat /etc/hosts

127.0.0.1 localhost

#127.0.0.2 demo.novell.com demo

192.168.1.5 demo.novell.com demo

In the example, remove or comment the line in bold as shown in themiddle line.

3. Enter the following command:

# nslookup <hostname>

In this instance, <hostname> is the hostname (without domain name) of themanagement
server.

4. Enter the following command:

# nslookup <IP address>

In this instance, <IP address> is the IP address of the server.

5. Verify that both results from nslookup have the same fully qualified computer name and IP
address.

Linux Installation Checklist
Print the following table and use it to track your progress. Check off each step as you complete it.

Step Need More information?

Did You
Complete This
Step?

Read the Release Notes and
the Support Matrix

"Step 1 – Read the Release Notes and the
Support Matrix" on the next page

Install theManagement
Server

"Step 2 – Install theManagement Server" on
the next page

Verify that Processes Can
Start

"Step 3 – Verify that Processes Can Start"
on page 52

Obtain a License Key "Step 4 –Obtain a License Key" on page 52

Verify Your Connection to
theManagement Server

"Step 5 – Verify Your Connection to the
Management Server" on page 53

Check for the Latest Service
Pack

"Step 6 – Check for the Latest Service
Pack" on page 55
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Step 1 – Read the Release Notes and the
Support Matrix

Read the Release Notes for late-breaking information not covered in the Installation Guide.

Read the support matrix to make sure the server on which you plan to install themanagement
server meet or exceed the requirements. Management server requirements are listed on the
Manager Platform (Mgr Platform) tab of the support matrix.

The Release Notes and support matrix can be found in any of the top-level directories of theHP_
SE_9.6.0DVD.

Step 2 – Install the Management Server
Keep inmind the following:

l Refer to the release notes for late breaking information.

l Your screen resolution should be at least 1024 pixels by 768 pixels; otherwise, youmight run
into issues with viewing the user interface for the software.

l If you receive amessage saying there is not enough room in the temp directory to perform the
installation, increase the amount of free space in the /tmp directory. For information on how to
increase the amount of free space, see the documentation for your operating system.

l Verify that the required software is available on your system as described in "Software
Dependencies" on page 42.

l The installation of the Oracle database on Linux does not work when the dba group exists in an
external database, such as LDAP. Disable LDAP authentication on the system when installing
HP Storage Essentials. Also ensure that the Linux group lookup is performed with files before
LDAP. For more information, see "Unable to Install the Oracle Database on Linux" on page 137.

l When you launch the Install/Migrate wizard using setup.bin, the following error message is
displayed:
strings: '/lib/libc.so.6': No such file

You can safely ignore this message and continue with the installation.

l In this release, no RPM entry is created for management server on Linux.

l When you install themanagement server on computer, youmust install the software using a
POSIX (Portable Operating System Interface) shell, such as sh. C Shell is not supported.

l Youmust install themanagement server on a Linux server with a non-loopback static IP
address.

l Do not mount the DVD to any system-level directory, such as /home, /tmp, /root, or /var. If
youmount the DVD to any of the system-level directories, the installation will not run. You can,
however, create a directory below /home, such as /home/Oracle_bits andmount
/home/Oracle_bits as a valid mount point. Youmust be careful about the permission
inherited from the parent directory. Some permissions might be restricted, such as executable
permission in setting up in a user profile. Make sure the directory you aremounting the DVD has
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executable permissions. Verify that the disk device where DVD is mounted has executable
permissions.

l To verify the operating system where you are installing HP Data Protector Reporter is
supported, the installer uses the following files:
n SUSE 11: /etc/SuSE-release

n RHEL 5.9 and 6.3: /etc/redhat-release

Make sure that you do not modify these files. If these files aremodified, the installer stops at the
operating system check in the Scan page of the Install/Migrate wizard.

l When you launch the Install/Migrate wizard, the following error message appears:
tar: jre/man/ja: time stamp 2012-03-01 22:45:08 is 1406639.690552586

s in the future

tar: jre/bin/ControlPanel: time stamp 2012-03-01 22:45:07 is

1406638.688267673 s in the future

tar: jre/lib/amd64/server/libjsig.so: time stamp 2012-03-01 22:45:08

is 1406639.469038533 s in the future

This message appears if the date and time on the computer where you are installing HP Data
Protector Reporter is not correct. You can safely ignore this message and continue with the
installation process.

l Youmust launch the wizard with a root user or a sudo user. You cannot launch the wizard using
a non-root user.

l To install HP Data Protector Reporter by remotely logging on to a computer, youmust set the
DISPLAY variable. If the DISPLAY variable is not set and you run the setup.bin file to launch the
Install/Migrate wizard, the installer exits without any error message.

l For amanagement server configured on dual-stack IPv6 network, make sure that the IPv4 and
IPv6 address is mapped to the same host name or canonical name in the server hosts file. If the
IPv4 and IPv6 addresses aremapped to a different host name or canonical name, a connection
cannot be established between HP Data Protector Reporter and Report Optimizer.
For example, if themanagement server is configured on a dual-stack IPv6 network, the server
hosts file must contain the following entries:
192.168.0.0 node1.foo.com node1

fc00:0db8::ff00:ac10:be01 node1.foo.com node1

1. Access the Linux host as described in "Accessing the Linux Host" on page 50. Your
installation options are the following:

n Install from the DVD:

i. Log on to the server as a user with root privileges.

ii. Insert theHP_SE_9.6.0DVD andmount it with the following commands: 
# mkdir -p /mnt/installer

# mount /dev/DVD /mnt/installer

In this instance, /dev/DVD is the DVD device.

iii. Verify themount point and disk device by entering the following command at the
command prompt:

# df -k
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The following is an example of what is displayed:

Filesystem           1K-blocks      Used Available Use%

Mounted on

/dev/cciss/c0d0p1     52924244  33893460  16880004  67% /

udev                  12344632       132  12344500   1% /dev

/dev/scd1                 85616     85616         0 100%

/media/ManagementServerDVD

In this instance, /dev/scd1 is the name of the disk device.

iv. Verify that the disk device where the DVD is mounted has executable permissions by
entering the following command at the command prompt:

#mount | grep /dev/scd1

In this instance, /dev/scd1 is the name of the disk device and
/media/ManagementServerDVD is amount point.

The word "noexec" is displayed if the directory you aremounting does not have
executable permissions, as shown in the following example:

/dev/scd1 on /media/ManagementServerDVD type iso9660 (ro,

noexec,nosuid,nodev,uid=0)

v. If the directory does not have executable permissions, remount the directory by
entering the following command:

# mount -o remount,exec /dev/scd1/

In this instance, /dev/scd1 is themount point.

n Install from ISO Copied to Local Server:

i. Create a directory on which the drive will bemounted:

# mkdir /InstallProduct

ii. Loopmount the HP_StorageEssentials_9.6.0.iso to the /mnt/installer directory.

# mount -o loop,ro /InstallProduct/HP_StorageEssentials_

9.6.0.iso /mnt/installer

2. Set the display for X Windows by entering the following at the command prompt.

Note: Youmust run the setup.bin script, which uses X Windows.

# /usr/X11R6/bin/xhost +

3. Set the display to your client. Refer to the documentation for your shell for more information.

4. Access the Linux host from a remoteWindows client.

Before running X Windows from a client system, make sure that X server is running on the
server that you plan to install the software.
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Note: ReflectionX Manager from Attachmate corporation is the tested XServer to install
the product. You cannot install the product using Xming as the XServer.

Start up a local X server, and connect through xterm to the remote system. The xterm session
automatically sets the DISPLAY variable to “localhost:displaynumber:screennumber”. Change
the display variable to point to the IP address of the client from which installer is launched with
the correct display number and screen number by entering the following command:

# DISPLAY=<ip-address>:displaynumber.screennumber

In this instance, <ip-address> is the address of the client from which the Installer script is
launched.

If you do not modify the value of the DISPLAY variable, the installer will launch with the default
display setting, and the Oracle installation will stop prematurely with a timeout error.

The following is an example of the display command:

# DISPLAY=172.168.10.15:0.0

5. Export the display by entering the following command:

# export DISPLAY

6. Enter the following at the command prompt.

# /mnt/installer/ManagerCDLinux/setup.bin

In this instance, youmounted the DVD to the /mnt/installer location.

7. When you see the introduction screen, read through the information. You should already have
read the release notes and verified that youmeet the requirements stated in the support matrix.
Click Next.

8. The installation scans the system to ensure that it meets the requirements. When the scan is
complete, click Next to proceed with the installation.

9. Select HP Data Protector Reporter option.
n HP Data Protector Reporter

n HP Storage Essentials

Refer to the online help in the wizard for more information about each product.

10. Click Next.

11. In the Install Option window, provide the Installation Location for the product. The default
installation location is the following: /opt/HP.

You can browse to a location by clicking theBrowse button or you can provide the default
location by clicking theRestore Default Folder button. The installation directory must not
contain spaces or special characters, such as the dollar sign ($).

12. TheOptions page displays the options that will be installed. The options are selected by default
because you previously selected the HP Data Protector Reporter option. Reporter and the
management server are automatically installed on the same server as part of the configuration
for HP Data Protector Reporter:
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n Management Server

n Reporter

13. Under the Oracle section, provide the location where you want to install Oracle. The default
location is /opt/oracle.

14. (Optional) Provide the path to the Oracle installationmedia in theMedia Path box. You will be
asked for it during the installation.

15. Click Next. On the Password page, type the password in thePassword field. This password is
used for the Data Protector Reporter Admin, Data Protector Reporter database user (appiq_
system), Report Optimizer Administrator, and Report Database user (appiq_system). Re-
enter the password in the Confirm Password field. Although the installer allows you to save the
passwordmultiple times, note that HP Data Protector Reporter will remember the last saved
password only. Click Next. Note that the installer remembers the password even if you
navigate using the Back button.

Note: The password policy enforces a few restrictions that do not allow you to enter some
character sets using the Install/Migrate wizard. An administrator can however change the
password after the installation is complete. See the following sections for more details on
how to change the passwords:

n To change Data Protector Reporter Admin and Data Protector Reporter database user
password using the Database Admin utility, see the sections Changing System
Account Passwords andChanging the Admin Password for theManagement Server in
the chapterDatabaseMaintenance andManagement of theHP Data Protector
Reporter User Guide.

n To change Report Optimizer Administrator password, see "Changing the Passwords
for Report Optimizer Accounts" on page 59

n To change the Report Database user password, see the sectionChanging the DB_
SYSTEM_USER Password in theHP Data Protector Reporter Report Database
Guide.

16. Review the list of requirements on the Verify page to know if the server meets the
requirements. The following table summarizes what each icon on the Verify page depicts: 

Icon Meaning

The server meets installation requirements.

Setting barely meets installation requirements. The installation will proceed but there
might be some issues. It is highly recommended you change the setting.

Setting does not meet the installation requirements. Even though the installation will
still proceed, the product might not work as expected after the installation. Resolve
the issue before proceeding with the installation.

17. Click Next. The Summary page displays the components to be installed and an estimate of the
time in hours:minutes:seconds it will take to complete installing each component.
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18. Click Install to start the installation. The Progress page provides a status of the installation for
each component. You are asked to provide the Oracle installationmedia location, if you did not
provide that in the Options page. If during installation, an error is observed, the installation
stops and the Resume button is enabled. You are also provided with a link to the error log file.
This error log file provides you the details of the error that occurred during the installation. You
must fix the error and then click Resume button to continue the installation.

Note: If you are shown a command line window for the Oracle Universal Installer, do not
close this window.

19. After the installation is complete, the progress bar on the Progress page shows 100%. Click
Next.

20. On the Finish page, copy the Unique Client ID number, and select one of the following options:

n Start HP Data Protector Reporter When "Finish" is Clicked. Start the product
immediately after clicking the finish page. This option starts the AppStorManager service
after you click the Finish button so you can access themanagement server. It might take a
few minutes for AppStorManager to finish starting.

n Start HP Data Protector Reporter later. This option requires you to start the
AppStorManager service at a later time, either manually or by rebooting the server. Users will
not be able to access themanagement server unless the AppStorManager service is running.

21. Click Finish to complete the installation process. A message box appears that provides you
the path to log on to the HP Data Protector Reporter management server.

22. Set the new Oracle database to ARCHIVE MODE to enable automatic RMAN backups. See
the User Guide in the Documentation Center (Help > Documentation Center) for steps.

Accessing the Linux Host
Access the Linux host by doing one of the following:

l Use the graphics console on the localhost

Run the following command at the command prompt:

# /usr/X11R6/bin/xhost +

Or

l Access from a remote Linux client

Make sure that the X server on the remote client can accept TCP connections:

a. Open /etc/X11/xdm/Xservers.

b. Verify that the line for the screen number 0 (the line containing :0 local) does not contain the -
nolisten tcp option. Remove the -nolisten tcp option if present. The line should look like the
following:

:0 local /usr/X11R6/bin/X

c. Enable TCP connections on the X server of the remote client:
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o SUSE – Edit /etc/sysconfig/displaymanager and set the following options to
yes:

DISPLAYMANAGER_REMOTE_ACCESS

DISPLAYMANAGER_XSERVER_TCP_PORT_6000_OPEN

Here is an example:

DISPLAYMANAGER_REMOTE_ACCESS="yes"DISPLAYMANAGER_XSERVER_TCP_

PORT_6000_OPEN="yes"

o RHEL (for gnome) – Edit /etc/X11/gdm/gdm.conf and set the DisallowTCP option
to false (uncomment if commented); for example:

DisallowTCP=false

d. If youmade any changes in the configuration files during the previous steps, reboot the
system for the changes to take effect.

e. Run the following command at the command prompt:

# /usr/X11R6/bin/xhost +

f. Set the display to your client. Refer to the documentation for your shell for more information.

Accessing the Linux Host from a Remote Client Using RealVNC

HP Storage Essentials supports the use of RealVNC Viewer Free Edition version 4.1 or later to
access the Linux host from a remote client. Refer to the RealVNC documentation for information on
how to configure the RealVNC server and how to use it to access the Linux host. Once you have
configured the RealVNC server, follow the instructions in the section, "Use the graphics console on
the localhost" on the previous page.

Accessing the Linux Host from a Remote Windows Client

Before running X Windows from a client system, make sure that X server is running on the HP
Storage Essentials management server.

Note: ReflectionX Manager from Attachmate corporation is the tested XServer to install the
product. You cannot install the product using Xming as the XServer.

Start up a local X server, connect through xterm to the remote system and set your DISPLAY
environment variable appropriately by using the following commands:

# DISPLAY=<ip-address>:displaynumber.screennumber

In this instance, <ip-address> is the address of the client from which the Installer script is launched.

# export DISPLAY

Here is an example:

# DISPLAY=172.168.10.15:0.0

# export DISPLAY
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Step 3 – Verify that Processes Can Start
After you install themanagement server, verify the process for themanagement server has started.
It might take some time for the process to start depending on the server's hardware. The process
must be running tomonitor andmanage your elements. Refer to the appropriate section for your
operating system.

Verify that the process for themanagement server started. Enter the following at the command
prompt:

# /etc/init.d/appstormanager status

The following is displayed if the process started:

Checking for Cimom Service...

Cimom Service - RUNNING.

Checking for appstormanager service...

appstormanager service - RUNNING.

If the process did not start, enter the following at the command prompt:

# /etc/init.d/appstormanager start

To stop the process, enter the following at the command prompt:

# /etc/init.d/appstormanager stop

The appstormanager service is available with the following options:

# /etc/init.d/appstormanager

Usage: /etc/init.d/appstormanager { start | stop | restart | status |

force-reload }

If the status indicates that the CIMOM service is not running, wait a few minutes. It usually takes
some time for the CIMOM process to start.

Step 4 – Obtain a License Key
See your product invoice for important information about licensing. If you are required to import a
license, copy your Unique Client ID (UID) number and follow the instructions in your product
invoice documentation to obtain and apply your license key. A valid license key is required to use
themanagement server and to collect data from amanaged element.

Verify that the following are enabled on your web browser:

l Cookies

l JavaScript

l Java

Additionally, make sure that the AppStorManager service is running. This servicemust be running
for the product to work.
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To obtain your HP Storage Essentials license, youmust have the UID. This ID is displayed in the
Installation Complete page of the HP Data Protector Reporter Install/MigrateWizard. If you did not
copy the Unique Client ID during installation, you can obtain the Unique Client ID after you log on
for the first time to HP Storage Essentials.

To obtain the UID from themanagement server, complete the following steps:

1. Log on to themanagement server.
a. Open a web browser and enter the URL of the server running themanagement server; for

example, http://www.myserver.com.

b. Type admin for the user name and the password that you provided in the Password page
of the Install/Migrate wizard, during the product installation.

2. Select Security > Licenses in themanagement server.

3. At the top of the page, select the unique client ID and press CTRL + C to copy it.

Follow these steps to obtain and import your HP Storage Essentials license:

1. Go to http://h30580.www3.hp.com/poeticWeb/portalintegration/hppWelcome.htm and select
theGenerate New Licenses option. Follow the steps for obtaining your license key. You will
need to provide your UID and HP Order ID (found on the entitlement certificate).

2. After you obtain your license, log on to themanagement server.
a. Open a web browser and enter the URL of the server running themanagement server; for

example, http://www.myserver.com.

b. Type admin for the user name and the password that you provided in the Password page
of the Install/Migrate wizard, during the product installation.

3. Import the license key:

a. Click theSecuritymenu.

b. Click Licenses from themenu.

c. Click the Import License File button.

d. Click theBrowse button. The file system of the computer used to access themanagement
server is shown.

e. Select the license file.

f. Click OK.

Step 5 – Verify Your Connection to the
Management Server

The appstormanager process must be running for you to connect to themanagement server.

Keep inmind the following:

l The license agreement, which is in PDF format, is displayed the first time you access HP
Storage Essentials. Install the latest version of a PDF reader, such as Adobe Acrobat Reader,
on the client you plan to use to access HP Storage Essentials for the first time. You can access
the latest version of Adobe Acrobat Reader at the following URL: http://www.adobe.com
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l If you do not have a license installed, you are asked to install the license. If you do not have a
valid license, contact customer support, as mentioned in the Documentation Center (Help >
Documentation Center). To install the license, select the Import License File button on the
Licenses tab (Security > Licenses).

l Make sure you do not have pop-up blocking software enabled. If yourWeb browser has an
option for blocking pop-ups, disable it. Themanagement server uses pop-ups for dialog boxes.

l Make sure JavaScript is enabled.

To access themanagement server:

1. Type one of the following in aWeb browser:

n For secure connections:

https://machinename

In this instance, machinename is the name of themanagement server.

n For nonsecure connections:

http://machinename

In this instance, machinename is the name of themanagement server.

2. If you receive an error message when you attempt to connect to themanagement server, the
appstoremanger process might be still starting. Wait for it to complete its start script.

Youmight see amessage like the following:

Receiving HTTP ERROR: 503 javax.ejb.EJBException: null;

CausedByException is: Unexpected Error; nested exception is:

java.lang.NoClassDefFoundError

Formore information, see "Receiving HTTP ERROR: 503When Accessing theManagement
Server" on page 138.

3. In themanagement server login page, type admin in theName box and the password that you
provided in the Password page of the Install/Migrate wizard in thePassword box, and then
click Login.

4. If you are shown the software license agreement and you agree with its terms, click the
Accept button.

To prevent the license agreement from being displayed each time you log on to the
management server, select Do not show me this again.

5. When you first log on to themanagement server, you are asked to provide a license.

a. To obtain a license, youmust provide the unique client ID from themanagement server. To
access the unique client ID, select Security > Licenses in themanagement server.

b. At the top of the page, select the unique client ID and press CTRL+C to copy it.

c. Paste the unique client ID into a text file.

d. Access theWeb site specified on the Activation Card for the product.

e. Follow the instructions provided at theWeb site.

f. Once you obtain your license, return to the license page (Security > Licenses).
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g. Click the Import License File button.

h. Select the license file you obtained from theWeb site and click OK.

6. If themanagement server does not detect a license, you are asked to import the license. Click
the Import License File button to install the license.

The license file can be obtained from customer support.

Step 6 – Check for the Latest Service Pack
A service pack could have been created since this release. Obtain the latest service pack at the
following location:

http://h20230.www2.hp.com/selfsolve/patches

Step 7 – Install the Java Plug-in on a Linux
Client

Several of the features in HP Storage Essentials require the Java plug-in. Install the Java plug-in on
the clients that will be accessing HP Storage Essentials through a web browser.

ForWindows clients, install the Java plug-in by following the prompts in the user interface.

For Linux clients, follow the steps described in this section.

For Linux 32-bit clients, see the following section.

For Linux 64-bit clients, see "Linux 64-bit Clients" on the next page.

Linux 32-bit Clients
To install the Java plug-in on a 32-bit Linux client running Firefox:

1. Navigate to the following directory:

<install_directory>/JBossandJetty/server/appiq/webapp/appiq

In this instance, <install_directory> is the installation directory for HP Storage Essentials.

2. Copy the file jre-6u38-linux-i586.bin and paste this file to the /usr/local directory.

3. Open command prompt and enter the following command to navigate to the /usr/local
directory:
cd /usr/local

4. Enter the following command to install the Java plug-in:

sudo sh jre-6u38-linux-i586.bin

5. After the installation is complete, youmust link the plug-in with the browser:
a. Enter the following command to navigate to the Firefox applications directory:

cd /usr/lib/mozilla
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b. Enter the following command to create the plugins subdirectory in the Firefox
applications directory. Follow this step only if plugins directory does not already exist:
mkdir plugins

c. Enter the following command to navigate to the plugins directory:
cd plugins

d. Enter the following command to link the plug-in:
ln –s /usr/java/jre1.6.0_38/lib/i386/libnpjp2.so

In this instance /usr/local/jre1.6.0_38/lib/i386 is the path to the
libnpjp2.so file.

6. Restart Firefox browser.

Linux 64-bit Clients
These steps are only for 64-bit Red Hat Linux.

To install the Java plug-in on a 64-bit Red Hat Linux client running Firefox:

1. Navigate to the following directory:

<install_directory>/JBossandJetty/server/appiq/webapp/appiq

In this instance, <install_directory> is the installation directory for HP Storage Essentials.

2. Copy the file jre-6u38-linux-x64.bin and paste this file to the /usr/local directory.

3. Open command prompt and enter the following command to navigate to the /usr/local
directory:
cd /usr/local

4. Enter the following command to install the Java plug-in:

sudo sh jre-6u38-linux-x64.bin

5. After the installation is complete, youmust link the plug-in with the browser:
a. Enter the following command to navigate to the Firefox applications directory:

cd /usr/lib64/mozilla

b. Enter the following command to create the plugins subdirectory in the Firefox
applications directory. Follow this step only if plugins directory does not already exist:
mkdir plugins

c. Enter the following command to navigate to the plugins directory:
cd plugins

d. Enter the following command to link the plug-in:
ln -s /usr/local/jre1.6.0_38/lib/amd64/libnpjp2.so

In this instance /usr/local/jre1.6.0_38/lib/amd64 is the path to the
libnpjp2.so file.

6. Restart Firefox browser.
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Log Files from the Installation on Linux
When an installation is successful, the Install/Migrate wizard zips up the log files and places them
in the Installation_Directory/logs directory. In this instance, Installation_
Directory is the directory where the product was installed.

The name of the zip file has a date stamp InstallWizard_MM_DD_YYYY_HH_MM_SS.zip; for
example, InstallWizard_12_12_2012-01_21_30.zip.

The zip file includes two internal log files created by the installation. These files contain debug
information for internal use only.

l /tmp/InstallSRMTemp/WizardSetup.log

l /tmp/InstallSRMTemp/Wizard.log

The log files are available at the following location:

<Installation_Directory>/logs

Removing HP Data Protector Reporter
Youmust have root privileges to run the uninstall scripts.

To uninstall themanagement server, enter the following at the command prompt:

/<InstallDir>/StorageEssentials/Uninstall_HP_Storage_

Essentials/Uninstall_HP_Storage_Essentials

To uninstall the Report Database, enter the following at the command prompt:

/<InstallDIR>/ReportDatabase/Uninstall_Storage/ Report/

Database/Uninstall/ Storage/ Report/ Database

To uninstall Report Optimizer, enter the following at the command prompt:

/<Report Optimizer install directory>/Uninstall_

HPSRMReportOptimizer/Uninstall_HPSRMReportOptimizer

To uninstall the Oracle database, insert the Oracle DVD and enter the following command:

./<Mount_Point>/UninstallDatabase

In this instance, <Mount_Point> is themount point for the DVD drive containing the Oracle DVD.
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Required Configuration Steps after
Installing Reporter

Youmust configure Reporter. If you observe any issues while generating reports, see the section
Troubleshooting Reporter in the HP Storage Essentials Installation Guide.

Changing the Passwords for Report Optimizer
Accounts

The Reporter installation provides the default passwords for the SQL Anywhere user account. The
default password is Password123.

Changing the Password for the Administrator
Account

If you have since changed the password and you do not remember the old password, you can reset
it, as described in theResetting the Administrator Password section in theHP Data Protector
Reporter Installation Guide.

To change the password for the Administrator account:

1. Log on to Central Management Console as described in "Accessing the Central Management
Console for Report Optimizer" on page 62.

2. In the Organize section, click Users and Groups.

3. Double-click Administrators.

4. Right-click Administrator and then select Account Manager.

5. Enter the new password in the Enterprise Password Settings section.

6. Click Save and Close for the new password to take effect.

Changing the Password for SQL Anywhere User
To change the password for SQL Anywhere user:

Windows:

1. Stop the Report Optimizer service BOE120SQLAW.

2. Open command prompt and navigate to the install location of the SQL Anywhere bin folder. By
default, the path is: <RO_Install_Dir>\SQLAnyWhere12\bin>.
In this instance, <RO_Install_Dir> is the Report Optimizer installation directory.
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3. Enter the following command:
dbisqlc -q -c "uid=<host_name>;pwd=<old_password>;dbf=<host_

name>.db" " alter user <host_name>identified by <new_password> ";

In this instance,
<host_name> is the host name of the computer where Report Optimizer is installed. Make sure
that you provide the host namewithout the hyphen character.
<old_password> is the old password. By default, this password is Password123.
<new_password> is the new password for the user.

4. Configure the password for data source using the following steps:
a. Click Start>Business Objects XI 3.1>Business Objects Enterprise>32-bit Data

Source (ODBC).

b. Click theSystem DSN tab.

c. Select the data source with name as <host_name_without_hyphen>.

d. Click Configure and then click Login tab.

e. Update the password in the Password field for the user with the name as <host_name_
without_hyphen>.

f. Repeat steps 4a through 4d for BOE120_AUDIT.

5. Right-click theBOE120Tomcat services in the Services Administration tool and select
Restart to restart Tomcat.

6. Start the Report Optimizer service, BOE120SQLAW, from Services, which is available from the
Windows Control Panel. See yourWindows operating system documentation for more
information on start a service onWindows.

Linux:

1. Open command prompt and navigate to the install location of the SQL Anywhere bin folder. By
default, the path is the following:
<RO_Install_Dir>/bobje/SQLAW/Bin

In this instance, <RO_Install_Dir> is the Report Optimizer installation directory.

2. Enter the following command to set the SQL Anywhere Library path:
export LD_LIBRARY_PATH=<RO_Install_Dir>/bobje/SQLAW/Lib

In this instance, <RO_Install_Dir> is the Report Optimizer installation directory.

3. Enter the following command at the command prompt:
./dbisqlc -q -c "UID=<host_name>;pwd=<old_password>;dbn=boe120"

"alter user <host _name> identified by <new_password> ";

In this instance,
<host_name> is the host name of the computer where Report Optimizer is installed. Make sure
that you provide the host namewithout the hyphen character.
<old_password> is the old password. By default, this password is Password123.
<new_password> is the new password for the user.

4. Restart Tomcat:
a. Navigate to the following directory:

<RO_Install_Dir>/bobje

In this instance, <RO_Install_Dir> is the Report Optimizer installation directory.
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b. Enter the following command to stop Tomcat:
./tomcatshutdown.sh

c. Enter the following command to start Tomcat:
./tomcatstartup.sh

5. Restart Report Optimizer:
a. Enter the following command to stop Report Optimizer:

/'etc/init.d/BobjEnterprise120 stop

b. Enter the following command to start Report Optimizer:
/'etc/init.d/BobjEnterprise120 start

Configuring the Report Database to Point to
the Management Server

If you are installing Reporter on the same server as the HP Storage Essentials management server,
you do not need to configure the Report Database to point to themanagement server.

To configure the Report Database to point to themanagement server:

1. To access the Report Database Admin Utility:

n Windows

Go to %REPORT_DATABASE_HOME% and double-click ReportAdmin.bat.

n Linux

i. Set the display if you are accessing the Report Database Admin Utility remotely.

ii. Go to the $REPORT_DATABASE_HOME directory by entering the following at the
command prompt:

# cd $REPORT_DATABASE_HOME

iii. Run the Report Admin Utility by entering the following at the command prompt:

# sh ./ReportAdmin.sh

2. Click Add.

3. Enter a site name in the Site Name box. The site name is used to differentiate the server from
other servers.

4. Enter the IP address of themanagement server. The Report Database uses this IP address to
contact themanagement server for report data.

5. Click OK. Themanagement server is set as the local management server.

Configuring a Global Report Database
Configuring a global report database enables you to use the Global Reports in Report Optimizer.

To configure a global report database:
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1. Add additional management servers on the “Set up report sources” screen.

2. By default, the first management server you enter is configured as the local management
server. Data from the local management server is used for the Standard Reports in Report
Optimizer. Tomake one of the other management servers the local server, click Configure
Report Database in the left pane.

3. Select another management server from the Standard Reports Use drop-downmenu, and click
Submit.

4. Click Set up report sources in the left pane. The selectedmanagement server becomes the
local management server.

5. To view updated reports immediately, click Refresh Data Now. Otherwise, updated reports
are available after the next report cache refresh is processed.

For additional details about configuring the Report Database, see the Report Database online help.

Accessing the Central Management Console
for Report Optimizer

Before you access the central management console for Report Optimizer, verify the following:

l JavaScript is enabled.

l Pop-ups are disabled.

If you are runningWindows Server 2008 with Internet Explorer Enhanced Security Configuration”
(IEESC) enabled, the server running Report Optimizer was added as a trusted site. See "Adding the
Report Optimizer Server as a Trusted Site" below.

1. Use a web browser to go to:

http://<fqdn_or_ip_address_of_Report_Server>:8080/CmcApp/logon.faces

2. Log on to the Central Management Console with the following credentials:

n Username: Administrator

n Password: The password that you provided during the installation in the Install/Migrate
wizard.

Adding the Report Optimizer Server as a
Trusted Site

If you are runningWindows Server 2008 with the Internet Explorer Enhanced Security Configuration
(IEESC) enabled, youmust add the server running Report Optimizer as a trusted site.

When you access Report Optimizer directly, you are prompted to add the site as a trusted site.

When you access Report Optimizer from within HP Storage Essentials, you are not prompted to
add the server as a trusted site and thus, youmight run into difficulty with accessing Report
Optimizer from within HP Storage Essentials.

Tomanually add Report Optimizer server as a trusted site:
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1. In Internet Explorer, click Tools > Internet Options > Security.

2. Click Trusted Sites and then click Sites.

3. Add several variations of the server name. For example, if the server running Report Optimizer
is named reportserver.usa.mycompany.com with IP address 192.168.1.1, you can enter the
following variations of the site name:

n The IP address of the server; in this example, http://192.168.1.1

n The full name of the computer; in this example, http://reportserver.usa.mycompany.com

n The computer name; in this example, http://reportserver

Installing a Named User Permanent License
Key

Adding a named user permanent license key enables you to log on as Administrator without
consuming a concurrent license.

To install a named user permanent license key:

1. Launch the Central Management Console as described in "Accessing the Central Management
Console for Report Optimizer" on the previous page.

2. In theManage section, click License Keys.

3. In the Add Key box, enter the named user license key. Click Add.

4. Return to the Central Management Console home page. In the Organize section, click Users
and Groups.

5. Select User List and then double-click Administrator.

6. In the Connection Type section, select theNamed User radio button.

7. Click Save and Close.

Setting the Report Parameters in HP Storage
Essentials

To set the report parameters in HP Storage Essentials:

1. In HP Storage Essentials, select Configuration > Reports, and click theReporter
Configuration tab.

2. In the Host Name or IP box, enter the host name or IP address of the server running Report
Optimizer.

3. In the Port Number box, enter the port number for accessing Report Optimizer. The default is
8080.

4. (Optional)Change the password for the ReportUser user account. Youmust have already
changed the password on the Report Optimizer server.
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a. Click Change Password.

b. Enter the old password (Welcome), enter a new password, and confirm the new password.

c. Click Submit.

Modifying the Server Session Timeout Value
Youmust change the server session timeout value to 120minutes, as follows:

1. Launch the Central Management Console as described in "Accessing the Central Management
Console for Report Optimizer" on page 62.

2. In the Organize section, click Servers.

3. Expand the Server Categories node, and clickWeb Intelligence.

4. Double-click theWebIntelligenceProcessingServer. The Properties window opens.

5. In theWeb Intelligence Processing Service section, enter 120 in the Idle Connection Timeout
box.

6. Click Save and Close.

Configuring Drill-Down Options
The drill-down options must be properly configured to synchronize graphs with drill-down reports.

To configure the drill-down options:

1. Log on to InfoView, as follows:

a. Go to http://<fqdn_or_ip_address_of_Report_Server>:8080/InfoViewApp/logon.jsp

b. Log on with a valid username and password.

2. In the upper-right corner of your browser, click thePreferences button.

3. ClickWeb Intelligence to expand that section.

4. In the Drill Options section, click the “Synchronize drill on report blocks” check box.

5. Click OK.

Disabling Browser Access to Desktop
Intelligence

Desktop Intelligence is not installed with Report Optimizer, so references to that feature should be
removed from the user interface.

To remove these references by disabling browser access to Desktop Intelligence:

1. Launch the Central Management Console as described in "Accessing the Central Management
Console for Report Optimizer" on page 62.

2. In theManage section on the home page, click Applications.
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3. Right-click Desktop Intelligence, and select User Security.

4. Click User Security, select Administrators, and click Assign Security.

5. Click theAdvanced tab.

6. Click Add/Remove Rights.

7. Click General under the General node.

8. Click theDenied radio button for every option:

n Edit this object.

n Log on to Desktop Intelligence and view this object in the CMC.

n Modify the rights users have to this object.

n Securely modify rights users have to objects.

9. Click OK.

10. Click Desktop Intelligence under the Application node.

11. Click theDenied radio button for the following options:

n Create Desktop Intelligence Documents

n Create Templates

n Save Desktop Intelligence Documents

n Save Documents for all users

n Use Templates

12. Click OK.

13. Click OK to apply the chosen settings.

14. Repeat these steps for the Everyone group.

Adding the Report Designers Group
Report Optimizer does not support Report Optimizer role-based security. The reports visible to a
user are determined by the access and security levels set in Report Optimizer.

Add the Report Designers group to allow easy addition andmodification of rights for users who will
have report creation, modification, and deletion rights.

To add the Report Designers group:

1. Launch the Central Management Console as described in "Accessing the Central Management
Console for Report Optimizer" on page 62.

2. Click Users and Groups in the Organize section.

3. Right-click Group List, and select New Group.

4. Enter Report Designers in the Group Name box.

5. Add the following text to the description:
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Report Designers group. Users added to this group will have the

rights and privileges to create, modify, and delete new and

existing reports.

6. Click OK.

Assigning Report Designing Privileges to
Report Designers

The Report Designers groupmust be assigned the appropriate application rights.

To assign the appropriate rights:

1. Launch the Central Management Console as described in "Accessing the Central Management
Console for Report Optimizer" on page 62.

2. In theManage section, click Applications.

3. Right-clickWeb Intelligence, and select Properties.

4. Click User Security in the left panel, and click Add Principals.

5. Select Report Designers and click > to add it to the Selected users/groups list.

6. Click Add and Assign Security. The Assign Security window opens.

7. Select Full Control and click > to add it to the Assigned Access Levels pane.

8. Click OK.

9. Return to the Central Management Console Home page.

10. In the Organize section, click Folders.

11. Right-click All Folders, and select Properties.

12. Click User Security, and then click Add Principals.

13. Select Report Designers and click > to add it to the Selected users/groups list.

14. Click Add and Assign Security. The Assign Security window opens.

15. Select Full Control and click > to add it to the Assigned Access Levels pane.

16. Click OK.

17. Return to the Central Management Console Home page.

18. In the Organize section, click Folders.

19. Expand the All Folders node, right-click Report Pack, and select User Security.

20. Click Add Principals, select Report Designers, and click > to add it to the Selected
users/groups list.

21. Click Add and Assign Security. The Assign Security window opens.

22. Select Full Control and click > to add it to the Assigned Access Levels pane.

23. Click OK.
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24. Return to the Central Management Console Home page.

25. In the Organize section, click Universes.

26. In the right-hand pane, right-click Report Connector, and select User Security.

27. Click Add Principals, select Report Designers, and click > to add it to the Selected
users/groups list.

28. Click Add and Assign Security. The Assign Security window opens.

29. Select Full Control and click > to add it to the Assigned Access Levels pane.

30. Click OK.

31. Return to the Central Management Console Home page.

32. In the Organize section, click Connections.

33. Right-click DB Connection, and select User Security.

34. Click Add Principals, select Report Designers, and click > to add it to the Selected
users/groups list.

35. Click Add and Assign Security. The Assign Security window opens.

36. Select Full Control and click > to add it to the Assigned Access Levels pane.

37. Click OK.

Best Practices
Always use the Report Designers group to add new users who can add, modify, and delete reports
and perform report relatedmanagement operations. This simplifies maintenance when privileges
and rights aremodified for all users who have report modification andmaintenance-related tasks.

Adding New Users to Report Optimizer
To add new users:

1. Launch the Central Management Console as described in "Accessing the Central Management
Console for Report Optimizer" on page 62.

2. Click Users and Groups in the Organize section, and click User List in the left-hand pane. All
of the valid users are listed in the right-hand pane.

3. Click Manage, and select New > New User.

4. Choose the Authentication type and enter user details. If you select LDAP/Windows or
AD/Windows NT, enter the username qualified with the appropriate domain; for example,
americas\username.

5. Select Concurrent User or Named User for the Connection type at the bottom of the page.

6. Click Create orCreate and Close.

7. Right-click the new user, and selectMember of.

8. Click Join Group.
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9. Select theReport Designers group and click > to add it to the Destination Group(s) list.
Remove the Everyone group from the Destination Group(s) list if it is included there.

10. Click OK.

The new user can now log on to the web interface at http://<fqdn_or_ip_address_of_Report_
Server>:8080/InfoViewApp/logon.jsp

If you changed the port number during installation, enter the selected port number instead of 8080.

For more information, see the “Managing Enterprise and general accounts” section of the “Managing
Users andGroups” chapter of theAdministrator’s Guide.

Best Practices
Assign rights to groups instead of individual users.

All users who need rights for the creation, modification, or deletion of reports should be added to the
Report Designers group.

All users who need view-only rights should be added to the Everyone group. The Everyone group
has view-only rights by default.

Changing the Server Intelligence Agent’s User
Account (for Monitoring Remotely Located
Files)

To change the Server Intelligence Agent’s user account:

1. Use the Central ConfigurationManager to stop the Server Intelligence Agent.

2. Right-click the Server Intelligence Agent, and select Properties.

3. Uncheck the System Account check box.

4. Enter theWindows user name and password:

Report Optimizer and themanagement server are installed on different machines. Both
machines must be in the same domain.

n Click the button to the right of the User field. The Browse User window opens.

n Click theChange button, and select the domain name.

n Click OK to return to the Browse User window.

n Select the appropriate user, and click OK to return to the Server Intelligence Agent window.

5. Click Apply, and then click OK.

6. Start the Server Intelligence Agent. The server process logs on to the local machine with the
specified user account. All reports processed by this server are formatted using the printer
settings associated with the user account you entered.
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Configuring Active Directory (AD)
Authentication

Active Directory is only supported onWindows for Report Optimizer.

Youmust configure Active Directory (AD) Authentication.

Create a Service Account
Create a domain account that can be used as a service account, and add this account to the local
Administrators group on the RO server.

1. Open the Account tab for the user you created andmake sure the "Password never expires"
checkbox is selected.

2. Add the Service Account user to the local Administrators group.

Register an SPN Account
To add an SPN for the service account of the Central Management Server (CMS):

1. Open a commandwindow.

2. Type the following command as a Domain Admin user:

SETSPN.exe –A<service_class>/<domain_name> <service_account>

In this instance:

n <service_class> means any desired name; for example, ROCentralMS)

n <domain_name> means the domain and server name of the service account; for example,
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DFDEV.COMPANY.COM)

n <service_account> means the domain user account you configured; for example, sa ser01

Input example:

Setspn.exe –A ROCentralMS/DFDEV.COMPANY.COM sa sero1

Output example:

Registering ServicePrincipalNames for CN=sa sero1,OU=Service Accounts,

OU=NCSUS,D

C=dfdev,DC=company,DC=com

ROCentralMS/dfdev.company.com

Updated object

Grant Rights to Service Account
Grant the service account the rights to act as part of the operating system on each RO server:

1. On the RO server go toStart > Control Panel > Administrative Tools > Local Security
Policy.

2. Expand Local Policies, and then click User Rights Assignment.

3. Double-click Act as part of the operating system and select Add.

4. Enter the name of service account you created and click OK.

5. Make sure the Local Policy Setting box is selected and click OK.

(Optional) Set Delegation Option
To set the Delegation option for the user:

1. Open the AD Service Account User within the AD Users and Computers tool.

2. Select the Delegation tab for the User.

3. Select Trust this user for delegation to specified services only andUse Kerberos Only.
OnWindows 2008, a delegation tab appears after an SPN is assigned. Select Trust this user
for delegation (Kerberos only).

4. Select Add > Users and Computers and enter the Service Account user.

5. Select the <service_class> name you specified in step 2.

6. Click OK.

Assign Account to Server Intelligence Agent
To set the AD service account to run the Server Intelligence Agent service:
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1. Go toStart Menu > Business Objects XI 3.1 > Business Objects Enterprise > Central
Configuration Manager and stop the Server Intelligence Agent.

2. Right-click the Server Intelligent Agent and select Properties.

3. In the LogOn As section, deselect the System Account and use the new AD account created
in step 1. The format should be selab\ro_svc.

4. Restart the Server Intelligence Agent.

If the service does not start properly, you have an account issue (such as password or rights)

Create WINNT Directory
Create the C:\WINNT directory and then create the krb5.ini and bscLogin.conf files in the
WINNT directory as follows:

1. Create the bscLogin.conf file, and copy and paste the following information into the file:

com.businessobjects.security.jgss.initiate {

com.sun.security.auth.module.Krb5LoginModule required;

};

2. Create the krb5.ini file, and copy and paste the following information into the file:

}[libdefaults]

}default_realm = <DOMAIN.COM>

}dns_lookup_kdc = true

}dns_lookup_realm = true

}[realms]

}<DOMAIN.COM> = {

}kdc = <ADSERVER>.<DOMAIN.COM>

}default_domain = <DOMAIN.COM>

}
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In this instance, <DOMAIN.COM> means theWindows Fully Qualified Domain Name (FQDN)
and <ADSERVER> means the Active Directory Domain Controller name. All names must
include only capital letters.

Set File Locations in Tomcat
To set the locations for the files in the Tomcat configuration:

1. Select Start > Programs > Tomcat > Tomcat configuration and click the Java tab.

2. Copy and paste the following lines into the JavaOptions section:

}-Djava.security.auth.login.config=C:\WINNT\bscLogin.conf

}-Djava.security.krb5.conf=C:\WINNT\krb5.ini

3. Open Central ConfigurationManager (Start > All Programs > BusinessObjects XI 3.1 >
BusinessObjects Enterprise > Central Configuration Manager).

4. Select the Apache Tomcat service and restart it.

Configure Active Directory Plug-In in RO
To configure the AD plug-in within the ConfigurationManagement Console of RO:

1. Log on as Administrator to the ConfigurationManagement Console.

2. On the Central Management Console home page, select Authentication from the drop-down
menu, and double-clickWindows AD.

3. Make sure the EnableWindows Active Directory (AD) check box is selected.

4. Set settings in the AD Configuration Summary section:
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a. Click “” beside the AD Administration Name, and enter an AD account that can read the
AD. This is used to bind to the domain and search for users trying to authenticate.

b. In the Default AD Domain box, enter the Fully Qualified Domain Name (using capital
letters).

5. Add any AD Groups in theMapped AD Member groups section.

6. In the Authentication Options section, select the Use Kerberos authentication radio button and
enter <service_account>@<DOMAIN.COM> (see step 2) as the Service principal name of
the service account. The domain namemust be in capital letters.

7. Make sure the following options are selected in the AD Alias Options section:

n "Assign each new AD alias to an existing User Account with the same name."

n "Create new aliases when the Alias Update occurs."

n "New users are created as concurrent users."

8. Click Update.

9. Make sure that AD Users or Groups is amember of the SE Report or Report Designer groups
within the ConfigurationManagement Console of RO.

Restart Tomcat
Stop and restart the Tomcat service using the Central ConfigurationManager.

Scheduling Reports Based on File Based
Events

If you scheduled reports based on file based events, youmust reschedule those reports after
migrating. See the “Using file-based events with scheduled reports” section of the HP Storage
Essentials Report Optimizer Quick Start Guide.

Setting Up an Email Server
To set up an email server:

1. Launch the Central Management Console as described in "Accessing the Central Management
Console for Report Optimizer" on page 62.

2. Click Servers. A list of all of the server processes running on your Report Optimizer server is
displayed.

3. Click Servers.

4. Double-click <your_servername>.destinationjobserver.

5. Click Destination.

6. Select Email from the Destination drop-downmenu, click Add, and populate your SMTP
server details.

7. Click Save orSave andClose.
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8. Double-click <your_servername>.AdaptiveJobServer.

9. Click Destination.

10. Select Email from the Destination drop-downmenu, click Add, and populate your SMTP
server details.

11. Click Save orSave and Close.

For more information, see the “Configuring the destination properties for job servers” section of the
“Managing and Configuring Servers” chapter of theBusinessObjects Enterprise Administrator’s
Guide.

Best Practices
Set up an email account like StorageReporter@mycompany.com and use this account for SMTP
mailings.

Tuning the Report Optimizer Server
The following are optional steps for further configuring your server.

This section contains the following topics:

l "Configuring a Set of User Groups as Read-Only Users" below

l "Disabling Servers that are Not Required " on page 77

l "Increasing theMemory Heap Size Value" on page 77

l "Adding a Folder for User-Created Custom Reports" on page 79

l "Deleting Duplicate Folders" on page 79

Configuring a Set of User Groups as Read-Only
Users

To configure a set of user groups as read-only users:

1. Log on to the Central Management Console as an administrative user.

2. In the Organize section, click Users and Groups.

3. Click theManage drop-downmenu, and select New > New Group.

4. Enter a group name, such as Report Viewers, in the Group Name box. Enter a description in
the Description box, and then click OK.

5. Click theManage drop-downmenu and select New > New User.

6. Enter an account name in the Account Name box, enter other details as appropriate, and then
click Create. Repeat this step to create additional users.

7. After entering the last user, click Create and Close.

HP Data Protector Reporter (9.6.0)Page 74 of 143



Quick Start Guide
Chapter 3: Required Configuration Steps after Installing Reporter

To integrate Active Directory users, see "Configuring Active Directory (AD) Authentication" on
page 69.

8. Select all the users you just created, right-click, and select Join Group.

9. From the Available Groups section, select the Report Viewers group, click > to move it to the
Destination Group(s) section, and then click OK.

10. Return to the Central Management Console Home page.

11. In the Define section, click Access Levels.

12. Click theManage drop-downmenu and select New > Create Access Level.

13. Enter a title in the Title box and click OK.

14. Double-click the access level you just created, and then click Included Rights.

15. In the right pane, click Add/Remove Rights.

16. In the left pane, select General > General, and then select the Granted radio button for the
following rights:

n Reschedule instances

n Reschedule instances that the user owns

n Schedule document that the user owns to run

n Schedule document to run

n Schedule objects that the user owns to destinations

n Schedule on behalf of other users

n Schedule on behalf of other users that the user owns

n Schedule to destinations

n View objects

n View objects that the user owns

17. In the left pane, select Content >Web Intelligence Report, and then select the Granted radio
button for the following rights:

n Download files associated with the object

n Export the report's data

n Refresh List of Values

n Refresh the report's data

n Save as CSV

n Save as excel

n Save as PDF

n Use Lists of Values

18. In the left pane, select Application > InfoView, and then select the Granted radio button for
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the following rights:

n View the favorites folder

n View the Inbox

19. In the left pane, select Application >Web Intelligence, and then select the Granted radio
button for the following rights:

n Enable drill mode

n Enable Java Report Panel

20. In the left pane, select System > Connection, and then select the Granted radio button for the
following rights:

n Data Access

n Use connection for Stored Procedures

21. In the left pane, select System > Universe, and then select the Granted radio button for the
following right:

n Data Access

22. Click OK andClose.

23. Return to the Central Management Console Home page.

24. In the Organize section, click Folders.

25. Click All Folders.

26. Click theManage drop-downmenu and select Top Level Security > All Folders.

27. Select Everyone, and click Assign Security.

28. Select View from the Available Access Levels section, and click > to move to the Assigned
Access Levels section.

29. Click Apply, OK, andClose.

30. Expand the All Folder node and select Report Pack. Right-click and select User Security.

31. Click Add Principals.

32. In the Available users/groups section, select Report Viewers and click > to move it to the
Selected users/groups section.

33. Click Add and Assign Security.

34. Uncheck the Inherit From Parent Folder and Inherit From Parent Group check boxes.

35. In the Available Access Levels section, select Report Viewers Access Level and click > to
move it to the Assigned Access Levels section.

36. Click Apply, OK, andClose.

37. Return to the Central Management Console Home page.

38. In theManage section, selectWeb Intelligence, right-click, and select User Security.

39. Repeat step 31 through step 37.
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40. In the Organize section, click Connections.

41. Click theManage drop-downmenu, and select Top-Level Security > All Connections.

42. Repeat step 31 through step 37.

43. In the Organize section, click Universes.

44. Click theManage drop-downmenu, and select Top-Level Security > All Universes.

45. Repeat step 31 through step 37.

Disabling Servers that are Not Required
The following servers are not required by Report Optimizer and should be stopped and set to the
Disabled state:

l Crystal Reports Cache Server

l Crystal Reports Job Server

l Crystal Reports Processing Server

l Desktop Intelligence Cache Server

l Desktop Intelligence Job Server

l Desktop Intelligence Processing Server

l Report Application Server

To disable these servers:

1. Launch the Central Management Console as described in "Accessing the Central Management
Console for Report Optimizer" on page 62.

2. In the Organize section, click Servers.

3. Select the servers, right-click, and select Disable Server.

Increasing the Memory Heap Size Value
Increasing thememory heap size value size will prevent potential error messages.

To increase thememory heap size value:

1. Click Start > Run. The Run dialog box appears.

2. Enter regedit in the Open text field.

3. Click OK. The Registry Editor appears.

4. Navigate to HKEY_LOCAL_
MACHINE/SYSTEM/CurrentControlSet/Control/Session

Manager/Subsystems.

5. Right-click theWindows key and selectModify.
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6. Edit the SharedSection value from 1024,3072,512 to 1024,3072,1024. Note that the
default value varies depending on theWindows version on which you have installed the Report
Optimizer server.

7. Navigate to either of the following:

n Windows 32-bit servers:

HKEY_LOCAL_MACHINE\SOFTWARE\Business Objects\Suite

12.0\default\WebIntelligence\Server\Admin\SwapTimeOut

n Windows 2008 64-bit servers:

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Business Objects\Suite

12.0\default\WebIntelligence\Server\Admin\SwapTimeOut

8. Edit this value to 1500 seconds. Alternatively, set this to a value higher than theWeb
Intelligence Processing Server connection time out value found in the Central Management
Console. This value is written in minutes. The default value is 20.

9. Close the Registry Editor.

10. Restart the Server Intelligence Agent service for the changes to take effect.

Creating a Server Group
Creating a server group that contains all of the Report Optimizer servers enables you tomodify the
status of the servers from the Central Management Console.

To create a server group:

1. Launch the Central Management Console as described in "Accessing the Central Management
Console for Report Optimizer" on page 62.

2. In the Organize section, click Servers.

3. Right-click Server Groups, and select New > Create Server Group.

4. In the Name box, enter Report Connector Services.

5. Click OK.

6. Click Servers List.

7. Select the following servers:

n AdaptiveJobServer

n AdaptiveProcessingServer

n CentralManagementServer

n ConnectionServer

n DestinationJobServer

n EventServer

n InputFileRepository

n ListOfValuesJobServer
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n MultiDimensionalAnalysisServicesServer

n OutputFileRepository

n ProgramJobServer

n PublicationJobServer

n ReportApplicationServer

n WebIntelligenceProcessingServer

8. Right-click the selected servers, and select Add to Server Group.

9. Select theReport Connector Services group, and click the > button.

10. Click OK.

Adding a Folder for User-Created Custom Reports
To add a folder for user-created custom reports:

1. Log on to InfoView.

n Go to http://<fqdn_or_ip_address_of_Report_Server>:8080/InfoViewApp/logon.jsp

If you changed the port number during installation, enter the selected port number instead of
8080.

n Log on with a valid username and password.

2. Right-click Public Folders, and select New > Folder.

3. Enter the following name for the folder:

<Customer Name> <Management Server Name> reports

Best Practices
Follow the naming convention described in "Adding a Folder for User-Created Custom Reports"
above. If multiple installations are being configured at the same time, specify themanagement
server name to uniquely identify each installation.

When exporting and importing end-user created reports for backup or support purposes, a unique
top-level folder name for the reports ensures that the reports are not overwritten. Unique folder
names for end-user reports also ensure that Report Pack updates do not overwrite user-created
custom reports.

Deleting Duplicate Folders
To delete duplicate folders:

1. Right-click the folder you want to remove.

2. Select Organize > Delete.

3. Click OK.
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First, follow the steps on theGetting Started page.

To access the Getting Started page:

1. Open a web browser and enter the following URL:

http://<name_of_the_management_server>

In this instance, <name_of_the_management_server> is the name of the server on which you
installed themanagement server. You can also provide an IP address.

2. In the Name text box, enter the following:

admin

3. In the Password text box, enter the following:

password

4. If the Getting Started page does not automatically appear, click Startup in the upper-right
corner.

Follow the steps on theGetting Started page. Make sure you import the license as directed.
Also, run the ConfigurationWizard from theGetting Started page. For more information about
the ConfigurationWizard, see "Launching the Backup Host Configuration and Discovery
Wizard" on page 88.

Prerequisites for Agentless Discovery of Data
Protector

If you have a CIM extension installed, the product will automatically use the CIM extension to
discover Data Protector.

Before you discover a Data Protector server that does not have a CIM extension installed, you
must do the following:

1. Install the Data Protector Client on themanagement server. See "Step 1 – Install the Data
Protector Client" on the next page.

2. Create the DPREPORTER user group for HP Data Protector Reporter. See "Step 2 – Create a
User Group for HP Data Protector Reporter" on page 84

3. (Windows Only) Start the AppStorManager service with the context of the local administrator.
"Step 3 – Start the AppStorManager Service with the Context of Local Administrator" on page
85
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4. Create a user in the DPREPORTER user group. See "Step 4 – Create a User within the
DPREPORTER User Group" on page 86

5. Install the Data Protector 6.1 patches on top of the Data Protector 6.1 client or upgrade to the
Data Protector 6.11 client. See "Step 5 – Install the Data Protector Patch" on page 87

Step 1 – Install the Data Protector Client
Install the Data Protector Client on the HP Storage Essentials management server as described in
the following steps.

l "Linux Installation Steps" below

l "Windows Installation Steps" below

Linux Installation Steps
To install the Data Protector Client:

1. Open the /etc/services file in a text editor, such as vi.

2. Search for 5555 in the text editor.

3. Comment the following two lines in the text editor as follows:

#personal-agent 5555/tcp # Personal Agent

#personal-agent 5555/udp # Personal Agent

4. Save the services file, and exit the text editor.

5. Copy the Data Protector tar file and extract the tar file.

6. Go to the LOCAL_INSTALL directory.

7. Run the Data Protector installation by entering the following command at the command
prompt:

./omnisetup.sh

8. When asked which components to install, select only the following:

n User Interface

n JavaGUI Interface

Windows Installation Steps
To install the Data Protector Client:
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1. Select theClient option in the SetupWizard and click Next.

2. Leave the Cell Manager name field blank and click Next.

3. Deselect all options, except for the User Interface option, which is selected in the following
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figure. Click Nextwhen done.

4. Complete the installation by following the steps in theWizard.

Step 2 – Create a User Group for HP Data Protector
Reporter

Ask your Data Protector Administrator to create a user group for HP Data Protector Reporter in the
Data Protector Cell Manager Console Client as follows:

1. Open the Data Protector Cell Manager Console Client.

2. Go toUsers. Right-click Users, and then click Add User Group.

3. Provide the user group name DPREPORTER.

4. Deselect theStart restore option in the Data Protector User Rights pane. This option is
selected by default.

5. Select the following user rights in the Data Protector User Rights pane:

n Device Configuration

n Media Configuration
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n Reporting notifications

The selections should resemble the following:

6. Click Finish to create the new user group.

Step 3 – Start the AppStorManager Service with
the Context of Local Administrator

1. (Windows only) Before creating the user, make sure that the AppStorManager service, which
is the service for HP Storage Essentials, is started on the HP Storage Essentials management
server with the context of a Local Administrator user as the LogOnUser. You can check in the
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properties of the Service as follows:

Step 4 – Create a User within the DPREPORTER
User Group

1. Ask your Data Protector Administrator to create a user within the DPREPORTER User Group
as follows:

2. Right-click the DPREPORTER group and select Add/Delete Users.

3. In the Name field, provide one of the following:

n Linux: The name of the user under which the HP Storage Essentials server process is
running. By default, this name is the ‘root’ user.

n Windows: The name of the user with which the HP Storage Essentials AppStorManager
service is running. You can determine the user by looking for the account specified in the
This Account field on the LogOn tab. In this case, the user is Administrator.

4. In the Group/Domain field, provide one of the following:

n Linux: The group information of the user under which the process is running. This can be
verified by running the command ‘id root’ on the HP Storage Essentials management server.

n Windows: The host name of the HP Storage Essentials management server, since the
AppStorManager service is started as the Local Administrator User.

5. In the Client field, select the DNS name or IP address of the HP Storage Essentials
management server.

6. Click >> to apply your new user.

7. Click Finish to add your new user to the user group.
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Step 5 – Install the Data Protector Patch
You need to install the following patch, depending the operating system of the HP Storage
Essentials management server, on top of the Data Protector 6.1 client or upgrade to the Data
Protector 6.11 client:

l Linux: DPLNX_00077

l Windows: DPWIN_00417

If you own a valid support contract, you can download patches from
http://support.openview.hp.com/selfsolve/patches. You need an HP Passport Account for login.
When you access the Patches Search page, select All Products SPIs and enter the name of
patch, such as DPWIN_00417, in the Optional: Enter keyword(s) or phrases field. Click Search.
The link to the patch appears under the Search button.

If you do not install the patch or do not upgrade to Data Protector 6.11, the following occurs in
BackupManager:
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l Media andmedia pools details do not appear for discovered backup hosts.

l Policy Details for any session are not displayed in the Policy Detail tab.

l Schedule Details for any session are not displayed in the Schedule Detail tab.

Launching the Backup Host Configuration and
Discovery Wizard

If you installed HP Data Protector Reporter, the Backup Host Configuration and Discovery Wizard
is available to you. The Backup Host Configuration and Discovery Wizard assists you perform the
initial discovery and configuration tasks using a single user interface. You can invoke theBackup
Host Configuration and Discovery Wizard from theGetting Started page.

Caution: Before you can discover Data Protector, youmust complete the requirements
provided in "Prerequisites for Agentless Discovery of Data Protector" on page 81.

The Backup Host Configuration and Discovery Wizard page displays the following tabs:

l Discovery – Helps you discover the hosts running the Data Protector server. It also provides
options to configure the discovery details and backup server schedule. See "Step 1 – Discover
Backup Host Address" below.

l Backup – Enables you to set values to retain the backup sessions in the database. See "Step 2
– Set Retention Value for Backup Session Data" on page 90.

l System –Helps you configure email notifications on reports and policies. You can assign an
SMT server from which themanagement server can send email notifications. "Step 2 – Set
Retention Value for Backup Session Data" on page 90.

l Reports – Provides options to schedule the Report Cache Refresh and configure the Reporter
Login. It also provides options to configure the Report Optimizer email and FTP server. See
"Step 4 – Configure Report Optimizer Settings" on page 91.

Step 1 – Discover Backup Host Address
TheDiscovery tab of the configuration wizard helps you configure and discover single or multiple
backup servers. Before you discover the backup hosts, youmust add and configure the backup
hosts.

HP Data Protector Reporter, by default, does not comewith MAPs. Therefore, you cannot discover
devices that haveMAPs, such as switches, arrays and CIM extension, even though this
functionality is displayed in the product andmentioned in the documentation. If you are running HP
Data Protector Reporter without MAPs, you can only discover the backup servers without a CIM
extension installed, as described in "Prerequisites for Agentless Discovery of Data Protector" on
page 81.

To configure a backup host:
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1. Provide the backup host's IP address, user name, and password as follows:

n Single server:

In the IP Address/ DNS Name box, type the IP address of the device and provide the host's
user credentials.

n Multiple servers:

o In the From IP address box, type the lowest IP address in the range of elements you
want to discover.

o In the To IP address box, type the highest IP address of the range of elements you want
to discover.

o Provide the host's user credentials (optional); otherwise, the default credentials will be
used.

n Select Import to import the IP addresses for discovery, and do one of the following:

o Click Browse to find an XML file containing the list of IP addresses to be discovered.

Or

o In the Filename box, provide a complete path to the file.

o In thePassword box, type the password for the discovery list. If the discovery list does
not have a password assigned to it, leave this field blank.

2. Configure the Discovery Details Schedule as follows:

n Select Add the Address to this schedule option.

n Select a name from theSchedule Name list, or select New Schedule to create your own
schedule name. Provide a name for the schedule.

n Type a description for the schedule.

n Set Next Schedule Run date and time. Click the calendar icon to select a date and time.

n Set Repeat Interval period. Type a value for interval and select an unit of time from the list.

However, you can choose to skip the above step.

3. Configure the Backup server schedule. You can enable the schedules for the following:

n Image collection

n Sessions collection

n Media collection

n Sessionmonitoring

n Drivemonitoring

4. Click Add. This validates the backup configuration details and saves it to the database. The
validated IP addresses of the Data Protector backup servers are listed in theAddresses to
Discover table.

After you configure the backup hosts, youmust discover them. You can also edit or delete the
backup hosts.

To discover the IP addresses from theAddress to Discover table:
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1. Select the IP addresses you want to discover.

2. Click Discover. The followingmessage appears: "Are you sure you want to discover the
selected IP addresses?"

3. Click OK to start the discovery process. This initiates Discovery Step 1 and Backup Data
Collection. The discovery status is displayed as "Discovery is in progress.." You can click on
the link to view the discovery logs.

To edit IP addresses from the Address to Discover table:

1. Select the IP addresses you want to edit.

2. Click Edit. The Edit window opens.

3. Edit the settings, and then click Save. The changes will apply to all the selected backup
servers.

You can also reset your changes by clicking theReset button.

To delete the IP addresses from the Address to Discover table:

1. Select the IP addresses you want to delete.

2. Click Delete. The followingmessage appears: "Are you sure you want to delete the
addresses?"

3. Click OK to delete the selected discovery addresses from the table.

After the configuration and discovery of backup hosts are complete, click Next to go to theBackup
tab.

Step 2 – Set Retention Value for Backup Session
Data

TheBackup tab of the configuration wizard provides options to set the retention value for the
Sessions to be stored in the database.

To set the retention value:

1. Type the number of days (a value between 30 and 1098) in the box.

2. Click Submit.

3. Click Next to go to theSystem tab.

Step 3 – Set Up Email Notifications
TheSystem tab of the configuration wizard helps you set notifications from themanagement server
on reports and policies.

To configure email notification:

1. Select Enable.

2. In theServer Name or IP Address box, type the DNS name or IP address of the SimpleMail
Transfer Protocol (SMTP) server, you want to use to send the email notification.

3. In thePort box, type the Port number.
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4. In the User Name box, type the user name for the SMTP server.

5. In the Password box, type the password of the above user.

6. In the Verify Password box, re-type the password.

7. In the Sender box, type the email address of the sender. This address is displayed in the From
box in the email.

8. If you want the replies to go to an email address other than the one specified In the Sender box,
type an email address you want to receive the replies to in the Reply box.

9. Click Save.

Click Next to go to theReports tab.

Step 4 – Configure Report Optimizer Settings
The Reports tab enables you to schedule a reports cache refresh and configure the reporter login.
You can also specify the email server to be used for sending the reports and the FTP server to post
the reports.

To schedule a reports cache refresh:

1. Select Enable.

2. Click the calendar icon to set the date and time for a scheduled task.

3. In the Time box, type the time in 24-hour format with the hour andminutes separate by a colon.
For example, 22:15. Click the date on which you want the task to run.

4. Click Set.

5. In theRepeat Interval box, type an interval. Select a unit of time from the list.

6. Click Save.

To configure the reporter login settings:

1. In theHost Name or IP box, type the IP of the Reporter Optimizer system.

2. In thePort Number box, type the port number.

3. Click Save.

You can also reset or change the password. When you click Reset the password, the password is
set to default.

To configure the Report Optimizer E-mail server:

1. Select a Job Server from the list.

2. In the Domain Name box, type the domain name.

3. In the Host box, type the IP address of the host.

4. In the Port box, type the port number.

5. In the User name box, type the user name.

6. Click Save.

To specify the Report Optimizer FTP server:
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1. In the Host box, type the IP address of the host.

2. In the Port box, type the port number.

3. In the Account box, type the user name.

4. In the User name box, re-type the user name as above.

5. Type password for the user.

6. Click Save.

Click Close to complete the discovery and configuration tasks and exit the wizard.

l Select Do not automatically display this page again option if you do not want to invoke the
Backup Host and Configuration wizard each time you log on to themanagement server.

l Click Close to exit the wizard without completing your configuration tasks. You can, at a later
stage, access the wizard by using theDiscoverymenu (Discovery >Wizard) or
Configurationmenu (Configuration >Wizard).
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Backup Manager
The BackupManager monitors the backup applications running on hosts managed by HP Storage
Essentials. It monitors the progress of backup processes and provides status on the physical
infrastructure that supports those processes. It also helps you visualize your backup configuration
and recovery setup.

The following topics in this section describe how to use the BackupManager and how to view
information about backup applications running in your storage environment.

l "About BackupManager" below

l "Viewing Running Sessions" on page 96

l "Determining Last Successful Backup" on page 97

l "Viewing Running Sessions" on page 96

l "About the Summary Backup Charts " on page 107

l "About the Tabs in the Topology Lower Pane " on page 109

l "Modifying Summary Backup Charts " on page 112

l "Viewing Charts for a BackupManager Host " on page 113

l "Printing Summary Charts " on page 113

l "Changing Collection Times for Media and Session Collectors" on page 113

About Backup Manager
The BackupManager enables you to:

l Monitor the overall status of the backup process.

l Visualize the backup configuration and recoverability of a file, directory, volume, or server.

l View the status of the physical infrastructure supporting the backup process, backup
application, backup server, network, tape library, andmedia.

l Obtain information on reasons for backup failures and advisory information for configuring new
back-up schedules.

BackupManager monitors the backup applications running on discovered hosts. To determine
which backup applications are supported, see the support matrix, which is accessible from the
Documentation Center.

Themanagement server is able to detect the presence of the following after you obtain backup
details:
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l Backup Application – A backup application (such as NetBackup, HP Data Protector, EMC
NetWorker, or IBM Tivoli StorageManager) serving as themaster in a backup hierarchy. A
backup application is responsible for managing other mediamanagers.

l Backup Manager Host – A managed host that is running the backup application. The IP
address of the BackupManager host must be specified in Step 1 of discovery before the backup
application can be discovered.

l Media Manager Application – A backup application functioning as a server to control the
media in a backup hierarchy. A mediamanager application can be responsible for managing
different types of hardware, such as tapes and drives.

l Media Manager Host – A host that has the backup application running as themediamanager
application. A mediamanager application and its host can be discovered through the Backup
Manager host (similar to the way that hosts are detected through a switch). If a mediamanager
host is discovered through a backupmanager host, themediamanager host is considered to be
“unmanaged,” meaning that themanagement server has discovered it, but cannot obtain
additional information about the element. If the IP address of themediamanager host is
specified in Step 1 of discovery, themediamanager host will be considered “managed.”

l Media – Any device that is used to store backup data, such as tape

l Media Pool – A logical grouping of the backupmedia

l Sessions – Scheduled and executed backup sessions

l Tape Library – A device hosting a collection of tapes

l Robot – An automated device inside the tape library; responsible for manipulating the tapes

l Backup Client – A host that is being backed up by a backup application. A backup client can be
managed as a non-generic element if its IP address appears in the discovery list. Otherwise,
backup clients that are identified through the backup application are considered generic
elements.

Only a single click on an element in the topology is required to obtain more information about the
element.

Master servers without the tape library connectivity are not shown in the drivemonitoring page.

When the tape library name provided by Data Protector and the name provided by the SMI-S agent
of the tape library do not match, a tape library is displayed as two different tape libraries, once as a
generic tape library and again as a discovered tape library.

Requirements for Backup Manager
The CIM extension supports only one backup solution on a host. For this reason, BackupManager
does not support both EMC NetWorker or NetBackupMaster Server, HP Data Protector Cell
Manager, and IBM Tivoli StorageManager on the same host. If EMC NetWorker or NetBackup
Master Server, Data Protector Cell Manager, and IBM Tivoli StorageManager are installed on the
same host, by default only Data Protector Cell Manager is discovered. EMC NetWorker or
NetBackupMaster Server and IBM Tivoli StorageManager are ignored by the CIM extension.

Before you can use the BackupManager feature, youmust follow these steps:
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1. Install a CIM extension on the host running the backup application. For information about
installing CIM extensions, see the Installation Guide.

2. Discover the host running the backup application, selecting the Include backup details option
( refer to theHP Storage Essentials Installation Guide). HP recommends that you also select
the Include infrastructure detail option, so you can alsomonitor andmanage the host itself.

Make sure you have at least 500MB available if you are using the host as a BackupManager
host in a large environment; for example, 300 clients, 25,000 sessions, and 500,000 images.

3. Schedule backup collection for your BackupManager hosts as described in theHP Storage
Essentials User Guide.

Determining if You Have Enough Media to Run a
Backup

If you are performingmany, or large, backups, you shouldmake sure you have enoughmedia
available for the backup. BackupManager provides several methods for determining this:

l Media tab – Provides information about the discoveredmedia, including its usage count.

l Media Pool tab – Provides information about media in the pools, such as whether it is
Available, Allocated, Frozen, or Suspended.

l Media Summary reports – Provides information about all discoveredmedia over a defined time
period.

To use thesemethods:

1. Click Backup Manager ().

2. Click the Topology tab on the right side of the window.

3. Expand the Backup Applications node in the left pane, and then select a BackupManager host.

4. If necessary, expand the lower pane so you can view theMedia andMedia Pool tabs.

5. Click theMedia tab in the lower pane. The following information is displayed:

n Media ID – The identification number of themedia

n Media Pool – The name of themedia pool

n Usage Count – How often themedia has been used

n Barcode – The barcode associated with themedia

n Retention – How long themedia is retained

n State –Whether themedia is Full, Available, or Active

To learnmore about a specific medium, select its row. Additional information is displayed in
the lower-right pane.

6. To learnmore about themedia pool that contains themedia, click theMedia Pool tab. The
following information is displayed:

n Media Pool – The name of themedia pool

n Backup Manager – The name of the BackupManager host to which themedia pool belongs
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n Media Manager – The name of themediamanager to which themedia pool belongs

n Library – The name of the library to which themedia pool belongs

n Available – Themedia is available for backup.

n Allocated – Themedia is currently either actively being used or has a valid backup on it.

n Frozen – Themedia will never become available for backup again, but it is still available for
restores.

n Suspended – Themedia will not be used again until all backups written to it expire. It is still
available for installations however.

You can also set up a policy that will notify you when the number of available media for a storage
pool is running low. For example, you could create a policy that sends you an e-mail when the
number of available media for a storage pool is less than two. Refer to theHP Storage Essentials
User Guide.

Viewing Running Sessions
For information about configuring sessionmonitoringrefer to theHP Storage Essentials User Guide.

To view sessions that are running:

1. Click Backup Manager ().

2. Click the Topology tab on the right side of the window.

3. Right-click a BackupManager application, and then select Show Running Sessions. The
Running Sessions page is displayed.

4. If desired, select filter criteria, and then click Apply Filter. The table is updated to display only
the sessions that meet the filter criteria you entered. The following information about each
session is displayed:

n Job ID – The identifier assigned to the session

n Backup Manager – The name of the backupmanager

n Media Manager – The name of themediamanager

n Clients – The names of the clients

n Backup Policies – The names of the backup policies

n Schedules – The names of the schedules

n Session Status – The session status: Success or Failure

n Session State – The session state: Done, Queued, or Active

n Media Used – The type of media used for the backup

Media Used information is not available for IBM Tivoli StorageManager.

n Start Time – The starting time and date of the session

n End Time – The end time and date of the session
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n Size – The size of the session in kilobytes (KB)

n Files – The number of files

After Caché is removed and the CIM extensions are installed, the first sessionmonitoring collection
collects all of the sessions for the past week. One hour after a fresh installation of Caché, these
sessions are removed from the Running Sessions page.

The Running Sessions page is automatically refreshed every twominutes. Tomanually refresh the
page, click Getting Latest Sessions.

For IBM Tivoli StorageManager, the sessions information is collected using the activity log.

Retrieving Restore Sessions from Data
Protector Cell Manager

By default, HP Data Protector Reporter does not retrieve the Restore Sessions from Data Protector
Cell Manager. To collect the restore sessions, complete the following steps on the host where the
Data Protector Cell Manager is installed:

1. Open theGlobal options file in a text editor. By default, this file is available at the location:
n Windows: C:\Program Files\OmniBack\Config\Server\Options

n Linux: /etc/opt/omni/server/options

2. Add the property EnableRestoreReportStats=1 and save this file.

Note: Restore Sessions are collected only after you enable the
EnableRestoreReportStats property. Previous Restore Sessions will not be retrieved.

Determining Last Successful Backup
BackupManager provides several tools to help you determine if the last scheduled backup was
successful. The quickest way to do this is from the Summary tab in BackupManager. The following
topics providemore information:

l "Viewing the Summary Backup Charts " below

l "Viewing Backup Results for a BackupManager Host" on the next page

l "Viewing Backup Results for a Client" on the next page

l "Viewing Backup Information for a Client" on page 99

Viewing the Summary Backup Charts
To access summary information about last night’s backup from the backup charts:

1. Click Backup Manager ().

2. Click theSummary tab on the right side of the window.
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By default, the Backup SLA Performance chart is displayed in the upper-left pane on the Summary
page. This chart includes the overall results of the backups made in the past 14 days. It tells you if
the overall backup was successful, partially successful, or failed.

For more information, see "About the Summary Backup Charts " on page 107 and "Modifying
Summary Backup Charts " on page 112.

Viewing Backup Results for a Backup Manager
Host

To quickly view the results of the backup sessions performed by a backup application:

1. Click Backup Manager().

2. Click the tab on the right side of the window.

3. In the left pane, expand the Backup Applications node, and then select the BackupManager
host.

4. If necessary, expand the lower pane so you can see the tabs.

5. Click the Sessions tab. BackupManager displays the following information for each session
the backup application performed:

n Session ID – The identifier assigned to the session

n Client – The name of the client

n Backup Policy – The name of the backup policy

n Schedule – The name of the schedule

n Status – The status of the backup: Success, Partial, or Failure

n Start Time – The starting time and date of the backup

n Duration – The amount of time in seconds it took for the backup to be displayed

n Size – The size of the backup in gigabytes (GB)

n Files – The number of files backed up

6. To learnmore about a session, select the session’s row in the table and see the Session
Detail, Policy Detail, and Schedule Detail tabs in the lower-right pane.

Viewing Backup Results for a Client
To view the results of the last backup for a client:

1. Click Backup Manager ().

2. Click the Topology tab on the right side of the window.

3. In the left pane, expand the Clients node, and then select the client.

4. In the topology pane, check the color of the check mark above the icon for the client. The icon
colors have the followingmeaning:
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n Green – The last backup on the client was successful.

n Yellow – The backup on the client was partially successful.

n Red – The backup on the client failed.

To view detailed backup information for a client, see "Viewing Backup Information for a Client"
below.

Viewing Backup Information for a Client
BackupManager tracks backup information for a client for the past 30 days. The Backup tab gives
an at-a-glance view of the backup coverage for a selected element. For example, you can select the
period for the coverage and review the policy, schedule, and results for the backups executed for
that period.

To obtain detailed information about the backup sessions for a client:

1. Click Backup Manager ().

2. Click the Topology tab on the right side of the window.

3. Select the client from the topology pane or from the tree in the left pane.

4. If necessary, expand the lower pane so you can view the Properties and Backup tabs.

5. Click theBackup tab to view the following information for each backup policy:

n Backup Policy – The name of the backup policy

n Schedule – The name of the schedule

n Date – The date, end time, and status

6. To learnmore about a policy or schedule, select a cell in the table. Additional information is
provided on the Policy Detail and Schedule Detail tabs in the lower-right pane.

About the User Interface for Backup Manager
BackupManager has an easy-to-use interface that provides the following options:

l Toolbar – Provides buttons andmenus to help youmodify the topology and charts in Backup
Manager (see "About the Toolbars in BackupManager" on the next page)

l Summary and Topology tabs:

n Summary tab – Displays summary charts for backup elements (see "About the Summary
Backup Charts " on page 107 and "Modifying Summary Backup Charts " on page 112).

n Topology tab – Displays the topology of the backup elements

The lower pane on the Topology tab becomes visible when you select a discovered element.
The tabs are determined by the backup element selected (see "About the Tabs in the Topology
Lower Pane " on page 109).

Access to Navigation, Events, Collectors, Policies, and Chargeback –When you click an
element on the Topology tab, the following links in the lower-right corner are enabled if that
feature is supported for the selected element:
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o Navigation – Displays the navigation information for an element, such as which storage
systems are connected to the element.Refer to theHP Storage Essentials User Guide.

o Events – Displays the events for the element. Refer to theHP Storage Essentials User
Guide.

o Collectors – Provides links to data collectors and reports about the element. Refer to theHP
Storage Essentials User Guide.

o Policies – Enables you to set up policies for the element. Refer to theHP Storage Essentials
User Guide.

o Chargeback – Enables you to provide chargeback information about the element. Refer to
theHP Storage Essentials User Guide.

You can also select an element and use the right-click menu options to obtain additional
information (see "Right-Click MenuOptions on the Topology Tab" on page 104).

About the Topology Icons in Backup Manager
The following table describes the icons that appear in the topology in BackupManager.

Icon Description

When a client computers is shownwith a green check mark, the backup on the computer
was successful.

When a client computers is shownwith a yellow questionmark, the backup on the
computer was partial.

When a client computers is shownwith a red X, the backup on the computer failed.

Host

Master backup server (media). This image is an example of amaster backup server for
NetBackup.

Backup server (media), such as NetBackup

Tape Library

Tape Drive

Topology Icons in Backup Manager

About the Toolbars in Backup Manager
BackupManager has two toolbars:

l Themain toolbar that appears at the top of its screen. See "Main Toolbar for BackupManager"
on the next page.

l The toolbar for charts that appears in themiddle of its screen. See "Toolbar for Charts" on page
102.

HP Data Protector Reporter (9.6.0)Page 100 of 143



Quick Start Guide
Chapter 5: BackupManager

Main Toolbar for Backup Manager
The following table provides a brief description of the buttons andmenus on themain toolbar in
BackupManager. This toolbar is available at the top of the BackupManager screen.

Button Description

Saves the current topology or summary page, so that when you return to Backup
Manager, the saved layout or summary is restored.

This option can be especially useful if you want to keep the new location of
elements you havemoved.

When you click the button, you are asked if you want the layout to apply to all
users.

l Yes – All users who log into themanagement server can view the topology or
summary you created. Only users with system configuration capability can
save their layout for all other users

l No – No other users can view the topology or summary you saved.

Prints the topology or the summary.

Enables you to view information from past backups. For example, if you want to
view a backup from last March, just click the Calendar icon, then select the date.

Enables you tomodify the summary charts. Enabled when the Summary tab is
active.

Magnifies the view. Enabled when the Topology tab is active.

Decreases themagnification. Enabled when the Topology tab is active.

Enables you to set themagnification to a percentage of the default magnification.
Enabled when the Topology tab is active.

Opens a smaller pane, which provides a global view of the topology. This enables
you to position themain view to a certain section of the topology (see Using the
Global View). Enabled when the Topology tab is active.

Fits the topology to the window, so you can view the entire topology. Enabled when
the Topology tab is active.

Enables you tomove an element in the topology (see Arranging Elements in the
Topology). Enabled when the Topology tab is active.

Enables you tomove the entire topology at once. Click thePan ( ) button, click
any place in the topology, and then drag themouse to a new location. Enabled
when the Topology tab is active.

Toolbar in Backup Manager
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Button Description

Opens a new window, containing the topology, which enables you to view different
domains of the topology at one time (see About the New Window Option ). Enabled
when the Topology tab is active.

Enables you to change the topology layout. Enabled when the Topology tab is
active.

Restores the topology layout to the last saved version. Enabled when the Topology
tab is active.

Enables you to find an element by name or by Worldwide Name (WWN) in the
topology. Enabled when the Topology tab is active.

To find an element, enter the name or part of the name in the Find box, and then
click the Find Next () button. Themanagement server highlights the elements that
match in the topology and in the tree.

If themanagement server has foundmultiple elements matching your search
criteria, click the Find Next () button to find the next element that matches your
search criteria.

To view the previous element that matches the search criteria, click the Find
Previous () button. The Find Previous () button is disabled when only one element
meets your search criteria.

Displays links between shared libraries. Additional connections betweenmedia
servers and tape libraries, andmedia servers and disk drives are displayed. If the
additional links between shared libraries are currently displayed, clicking the Show
MultiPath button a second time will hide the links.

ChangeObserver button –Monitors changes in the database status on the server.
When changes are detected, the button turns amber. Click on the amber button and
a pop-up window displays the elements that have changed on the server. When no
changes are detected, the button is grayed out.

Reloads the ChangeObserver button to display the latest changes to elements on
the server.

Toolbar in Backup Manager, continued

Toolbar for Charts
To view a chart on the Topology tab, click an element in the topology. The following toolbar options
are available.

Option Description

Converts the data in the chart to a list in a separate browser.

Click to print a chart. See "Printing Summary Charts " on page 113 for more information.

Toolbar for Charts
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Option Description

Click to switch the X and Y axes in a chart.

To change the chart displayed, select another chart from the Title menu (see "About the
Summary Backup Charts " on page 107).

To change the period displayed in the chart, select a period from the Periodmenu.

In Service Level Agreement charts, BackupManager provides a green line that serves
as a baseline. Use the Average Service Level menu to change the location of this
baseline. The default baseline value is 95% of usage.

Toolbar for Charts, continued

Changing the Topology Settings
TheDisplay Layout Settings Dialog ( ) button enables you tomodify the following properties of
the topology in BackupManager:

l Direction – Horizontal or Vertical. The direction of the topology is Horizontal by default, with
multiple elements of the same type displayed in a row. If you select Vertical, multiple elements
of the same type are displayed in a column.

l Alignment – Left, Right, or Center. The default alignment of the topology is Center. You can
change the alignment of the topology to be left- or right-justified. For example, if you select the
Left, the backup clients are aligned along the left side of the topology window.

l Horizontal Spacing – The number of spaces in pixels between elements in a row

l Vertical Spacing – The number of spaces in pixels between elements in a column

To restore the layout to the default settings, click Defaults.

To change the layout settings:

1. Click Backup Manager ().

2. Click theDisplay Layout Settings Dialog button.

3. Select one of the following directions:

n Horizontal

n Vertical

4. Select one of the following alignments:

n Left

n Right

n Center

5. To change the horizontal spacing, enter a new number in the Horizontal Spacing box.

6. To change the vertical spacing, enter a new number in the Vertical Spacing box.

7. Click OK.

Youmight need to use the scroll buttons to see the rearranged topology.
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Right-Click Menu Options on the Topology Tab
When you right-click an element on the Topology tab or in the Backup Applications tree, a list of
options is displayed. The options displayed in themenu depend on the type of element you
selected.

The following table describes themenu options displayed when an element is right-clicked on the
Topology tab or in the Backup Applications tree.

Right-Click Menu
Option Description

Go ToNavigation
Details

Directs you to the Navigation page. If the element is labeled Discovered,
you are shown the Properties page. An element is labeled unmanaged when
themanagement server has become aware of it, but cannot obtain
additional information about it (see About the Navigation Tab).

Show Events Displays events for the selected element (see About the Events Tab).

Show Policies Displays the backup policies for the selected element (see About the
Policies Tab).

Show Collectors Displays the report collectors for the selected element (see About the
Collectors Tab).

Show Chargeback Displays the chargebacks for the selected element (see About the
Monitoring Tab).

Update Element
Data

Themanagement server gathers new and changed details from the element
and then redraws the topology with the updated information.

Important:

The Update Element Data functionality does not detect element
components that have been removed, such as ports and LUNs. For
example, assume you removed several LUNs from an array. If you right-
click the storage system, and then select Update Element Data, the
deleted LUNs still appear in the user interface. Youmust perform Get
Details for the deleted LUNs to be removed from the user interface.

For more information, see "Right-Click MenuOptions on the Topology Tab"
above.

Right-Click Menu Options on the Topology Tab
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Right-Click Menu
Option Description

External Tools Provides several ways to access an element:

l Telnet – Enables you to access a host or a switch through the telnet
utility. The Telnet feature is only accessible toWeb browsers on
Microsoft Windows operating systems.

l Browse – Enables you to access themainWeb page for a host or a
switch.

l Set Up External Tools – Enables you to add URLs for accessing the
management tools for the storage system. In some instances, the
management tool for the storage system is directly accessible from this
menu (for example, HiCommand for HDS storage systems and
Command View for HP XP storage systems).

See Using External Tools

Add Virtual
Application

Enables you to add an unsupported application so you canmonitor it. For
example, youmight want to add a virtual application so you canmonitor
software that was created uniquely for your company.

See Creating a Virtual Application.

Custom
Commands

Enables you to run a custom command on an element; for example to start
an executable or a script. See Setting UpCustom Commands.

Go to System
Manager

Provides a topology that enables you to view how the devices in your
network are connected. See About .

Show
MultiPath/Remove
MultiPath

Displays links between shared libraries. Additional links betweenmedia
servers and tape libraries, andmedia servers and disk drives are displayed.
If the additional links between shared libraries are currently displayed, the
menu option becomes RemoveMultiPath. Selecting RemoveMultiPath
hides the links between shared libraries.

Delete Element This option enables you to delete a backup element in the topology.

Right-Click Menu Options on the Topology Tab, continued

The charts in BackupManager provide a wealth of information about your backups. You can obtain
detailed information about a data point displayed in a chart by right-clicking the data point. For
example, assume you are looking at a Service Level Agreement (SLA) chart on the Summary tab
and you want to obtain more information about a backup performed yesterday. You could right-click
the bar yesterday’s date, and then select Show Details to display the Sessions tab showing the
additional details of that data point, such as the backup status of each client, in addition to the start
and end time of the backup on that client.
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Right-
Click
Menu
Option Description

Summary
Page
Settings

The settings for the charts provided on the Summary tab are displayed. See "About
the Summary Backup Charts " on the next page and "Modifying Summary Backup
Charts " on page 112.

Go To
Topology

A graphical representation of the path of an element is displayed. This also includes
multipathing. See Viewing Element Topology.

Show
Details

The additional information about the data point you right-clicked is displayed. See
the following table.

Right-Click Menu Options on the Summary Tab

The following table explains what is displayed when you click Show Details on the Summary tab’s
right-click menu option.

When additional information is not available for a data point, Show Details is disabled.

When you right-
click a bar and
select Show
Details in the
following chart... The Sessions tab displays the following information:

Service Level
Agreement

Clients that were backed up, whether successfully or not. The failures are
displayed first. To obtain details about a session, select the session in the
Session tab and then expand the View the Details pane on the far right.
The status you right-clicked is highlighted in the Sessions tab.

Backup Volume Clients in the backup, sorted by size.

Windows Utilization
Chart

The time span represented by the bar you clicked is highlighted in the
Sessions tab. For example, assume a bar in theWindows utilization tab
shows a duration of seven hours. To determine which sessions were
running during that time, right-click the bar, and then select Show Details.

Largest Sessions Clients in the backup, sorted by the size of the session.

Longest Sessions Clients in the backup, sorted by duration of the session.

Additional Information from Charts on the Summary Tab

You can also obtain additional information from some of the charts that are displayed on the bottom
pane of the Topology tab.

Right-click... Select Show Details to view...

Any data point on the Charts
tab

The Sessions tab for the data point you right-clicked.

Show Details for Tabs on the Lower Pane of the Topology Tab
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Right-click... Select Show Details to view...

Any element on the Servers
tab

The Sessions tab showing the sessions for the element you
right-clicked.

Any element on the
Resources tab

TheMedia tab for the element you right-clicked.

Any element on theMedia
Pools tab

TheMedia tab for the elements contained in themedia pool you
right-clicked.

Show Details for Tabs on the Lower Pane of the Topology Tab, continued

About the Summary Backup Charts
BackupManager displays six summary backup charts on the Summary tab by default and offers
many other charts as well. To learn how to display the various charts and/or modify which charts
display by default, see "Modifying Summary Backup Charts " on page 112.

View Description

Servers Displays the servers BackupManager monitors with the following information for
each server:

l Volume

l Sessions

l Failed

l Partial

l Successful

Resources Displays the resources BackupManager monitors, showing the following
information for each server:

l Media Pools

l Available media

l Allocated

l Frozen

l Suspended

In the Available Media, Allocated, Frozen, and Suspended columns, the first
number shows the number of available onlinemedia, and the second number
shows the number of available offlinemedia. This information is available only to
the backupmanager host.

Backup Manager Summary Charts
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View Description

Service Level
Agreements
(SLAs)

Displays the performance of backup SLAs, showing the percentage of the
following types of sessions for each SLA:

l Successful sessions

l Partial sessions

l Failed sessions

Backup
Volume

Displays the backup volume of all backup applications in gigabytes (GB). This
chart can also display the backup volume of a backupmanager host.

Window
Utilization

Displays the number of hours it takes for all backup sessions on a server to run.
Keep inmind this timemight seem extended if you have overlapping sessions.

For example, bsession1 starts at 11 p.m. onMonday. While it is running,
bsession2 starts. At 2 a.m. on Tuesday, bsession1 stops, but bsession2
continues to run until 9 a.m. on Tuesday. TheWindows Utilization report shows
the backup sessions running for 10 hours – from the beginning of the bsession1
to the end of bsession2.

Backup
Manager
Hosts with
Most
Executed
Sessions

Displays the five backupmanager hosts with themost executed sessions. Only
successful sessions are counted.

Most
Unsuccessful
Backup
Manager
Hosts

Displays the five backupmanager hosts with themost unsuccessful sessions.
Unsuccessful sessions include failed and partially completed sessions.

Servers with
Most
Available
Media

Displays the five backupmanager hosts with the largest number of media in the
Available state and for each of the displayed hosts, the chart shows media that
is Allocated, Frozen, or Suspended.

Servers with
Fewest
Available
Media

Displays the five BackupManager hosts with the lowest number of media in the
Available state. The chart displays the following states:

l Allocated

l Frozen

l Suspended

l Available

Five Largest
Sessions

Displays the five largest sessions in gigabytes (GB).

Backup Manager Summary Charts, continued
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View Description

Five Longest
Sessions

Displays the five longest sessions in seconds.

Backup Manager Summary Charts, continued

About the Tabs in the Topology Lower Pane
The lower pane on the Topology tab is displayed when you select a discovered backup element.
The following tabs are displayed according to the element type you selected.

Tab
Element
Type Description

Properties All elements Provides property information for an element, including information
about whether the element supports backup.

Backup Clients Provides information about the last time the client was backed up.
See "Viewing Charts for a BackupManager Host " on page 113 for
more information.

Charts l Backup
Manager
Hosts

l Media
Managers

l Tape
Libraries

Shows a chart for the selected element.

Servers l Backup
Manager
Hosts

l Media
Managers

Displays the servers BackupManager monitors with the following
information for each server:

l Volume – The size of the volume backed up, in kilobytes

l Sessions – The number of backup sessions that have run in the
specified time

l Failed – The number of failed sessions during the specified time

l Partial – The number of partial sessions during the specified
time

l Successful – The number of successful sessions within the
specified time

Tabs in the Lower Pane of Backup Manager Topology
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Tab
Element
Type Description

Resources l Backup
Manager
Hosts

l Media
Managers

l Tape
Libraries

Displays the resources BackupManager monitors with the
following for each server:

l Media Pools – The number of media pools that the backup
manager host can access

l Available Media

l Allocated

l Frozen

l Suspended

In the Available Media, Allocated, Frozen, and Suspended
columns, the first number shows the number of available online
media; the second number shows the number of available offline
media. Note that this information is available only to the backup
manager host.

Sessions l Backup
Manager
Hosts

l Media
Managers

Displays the following information for the sessions assigned to a
backup server:

l Session ID – The identifier for the session

l Client – The DNS name of the computer on which the session
is taking place

l Backup Policy – The name of the backup policy

l Schedule – The name of the schedule for the session

l Status – The status of the session

l Start Time – The time the session started

l End Time – The time when the session ended

l Duration – The amount of time in seconds the session ran

l Size – The size of the session

l Files – The number of files that were backed up

Media l Backup
Manager
Hosts

l Media
Managers

l Tape
Libraries

Displays the following information for themedia attached to a
backup server or tape library:

l Media ID – The identifier for themedia

l Media Pool – Themedia pool to which themedia belongs

l Usage Count – How often themedia is used

l Retention – How long themedia is retained

l State –Whether themedia is Full, Available, or Active

Tabs in the Lower Pane of Backup Manager Topology, continued
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Tab
Element
Type Description

Media
Pool

l Backup
Manager
Hosts

l Media
Managers

l Tape
Libraries

Displays the following information for themedia pools containing
the selected element:

l Media Pool – Themedia pool to which themedia belongs

l Backup Manager – The name of the backupmanager host in
themedia pool

l Library – The name of the library in themedia pool

l Available Media – The number of available media

l Allocated – The number of allocatedmedia

l Frozen – The number of frozenmedia.

l Suspended – The number of suspendedmedia

Drive
Utilization

l Tape
Libraries

l Drives

Displays the following information for the drives in a tape library:

l Library – The name of the tape library that contains the drive

l Drive – The name of the drive

l Media ID – Themedia identifier

l Status – The running status of the drive

For information about configuring drivemonitoring, the section
Configuring theManagement Server in theHP Storage Essentials
User Guide.

Tabs in the Lower Pane of Backup Manager Topology, continued

Sorting Information in the Lower Pane
You can sort the information displayed on the tabs in the lower pane by clicking the heading of a
column. You can also sort more than one column at a time. The sorting feature for multiple columns
can be extremely useful. For example, if you have several clients with failed backups, you would
take the following steps to sort the table to show the clients according to their status:

1. Click theStatus heading in the session column to sort the sessions according to status.

2. Press theCTRL key, and then click theClient heading.

The clients are sorted first according to their status and second according to their client name. You
can now easily view all clients with failed sessions in alphabetical order.

You can sort as many columns as you want on a tab. The arrow indicates ascending or descending
sort order. The arrow decreases in size for each additional column that is sorted. The largest arrow
corresponds to the column that is sorted first, the second largest arrow corresponds to the second
sort, and so on.

HP Data Protector Reporter (9.6.0)Page 111 of 143



Quick Start Guide
Chapter 5: BackupManager

Modifying Summary Backup Charts
You canmodify BackupManager to display charts other than the default. To learnmore about the
data and options available in the Summary Backup charts, see "About the Summary Backup
Charts " on page 107.

The Summary Settings page shown below displays a grid that lists the charts available on the
Summary tab in BackupManager. To change a chart, select a grid on the this page and change the
settings as described in the steps in this section.

The top four grids on the Summary Settings page correspond to the top four charts on the Summary
tab, and the lower four grids on the Summary Settings page correspond to the lower Summary tab.
There are only two tables on the bottom half of the Summary tab because each of the tables spans
two grids.

Summary Settings Page for Backup Manager Charts

You can alsomodify the Summary tab instantly by clicking one of the buttons displayed in the
Summary Settings page. The following table describes these buttons.

Button Description

Clear All Clears the settings for all the charts.

Clear Clears the settings for the selected chart.

Revert Returns the Summary Settings page to the previous setting.

Defaults Returns the Summary Settings page to the default setting.

Buttons on the Summary Settings Page

Tomodify a chart displayed on the Summary tab in BackupManager:

1. Click Backup Manager ().

2. Click the icon.

3. To change the title for the summary page, enter a new title in the Title box.

4. Select the grid in which you want the chart to appear on the screen.

5. Select one of the following options from the Backup Element menu:

n Backup Applications – The chart includes the results from all backup applications.

Or

n A specific backup element – The chart includes the results from only the backup
application you selected.

6. Select the type of chart you want from the View menu. To learnmore about the available
charts, see "About the Summary Backup Charts " on page 107.

7. Select a period for coverage from the Periodmenu.

8. Click OK.
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The Summary page is updated with your changes and the chart accessed from the selected grid will
reflect your changes.

Viewing Charts for a Backup Manager Host
To quickly view charts for a backupmanager host:

1. Click Backup Manager().

2. Select the backupmanager host on the Topology tab.

3. Click theCharts tab in the lower pane.

4. Select a chart from the Title menu.

5. Select a period of coverage for the chart.

To learnmore about the charts in BackupManager, see "About the Summary Backup Charts " on
page 107.

See "Toolbar for Charts" on page 102 for information about the toolbar for charts.

Printing Summary Charts
To print a summary chart:

1. Access a backup summary chart by clicking an element on the Topology tab.

2. Scroll to the bottom of the screen.

3. Click thePrint ( ) button.

4. Click Landscape at the top of the new window if you want the picture to be printed in
landscape format. To revert to portrait format, click Portrait.

5. To change themagnification of the image on the printed page, select the desired percentage.

6. Click Printwhen you are ready to print the chart.

Changing Collection Times for Media and
Session Collectors

For CIM extension hosts with Data Protector installed, the CIM extension queries the data from
DataProtector for session andmedia details and puts the data into the cache database as soon as
the CIM extension is started.

The background collection occurs every 15minutes for sessions and every 24 hours for media.

Changing the Frequency of Collection Times
To change the collection time for the session andmedia collectors:
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1. Check if the dp-connector.properties file exists in the following directory on the host
with the CIM extension:

n Windows hosts: C:\Program Files\APPQcime\CimExtensions\tools

n Linux, Solaris, and HPUX hosts: /opt/APPQcime/tools

2. If the dp-connector.properties file does not exist, create it in the directory specified in
the previous step.

3. Add the following properties to the dp-connector.properties file if they do not exist in
the file:

cachedb.sessions.waitBgCollection=300000

cachedb.media.waitBgCollection=3600000

The time shown in the example is in milliseconds.

4. Set the values.

n cachedb.sessions.waitBgCollection Corresponds to the amount of time before
the next collection for a session.

n cachedb.media.waitBgCollection Corresponds to the amount of time before the
next collection for amedia.

5. Save the file.

Stopping Background Collections when a CIM
Extension Starts

You can stop the background collection whenever a CIM Extension starts. In this case, the session
andmedia collection will be started only for each get details that includes backup details.

To stop background collections when a CIM extension starts:

1. Check if the dp-connector.properties file exists in the following directory on the host
with the CIM extension:

n Windows hosts: C:\Program Files\APPQcime\CimExtensions\tools

n Linux, Solaris, and HPUX hosts: /opt/APPQcime/tools

2. If the dp-connector.properties file does not exist, create it in the directory specified in
the previous step.

3. Add the following properties to the dp-connector.properties file if they do not exist in
the file:

BUMODEL.startScheduler=no

BUMODEL.forceStart=yes

4. Save the file.
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Changing the Number of Days Session is Stored in
the Cache Database

Seven days of session data is stored in the cached database by default.

To change the number of days session data is stored in the cached database:

1. Check if the dp-connector.properties file exists in the following directory on the host
with the CIM extension:

n Windows hosts: C:\Program Files\APPQcime\CimExtensions\tools

n Linux, Solaris, and HPUX hosts: /opt/APPQcime/tools

2. If the dp-connector.properties file does not exist, create it in the directory specified in
the previous step.

3. Add the following property to the dp-connector.properties file if it did not previously
exist in the file:

sessions.timeframe=2592000000

The time in the example is in milliseconds. The value assigned to the sessions.timeframe
property is in milliseconds (30 days).

4. Save the file.

Known Issues
l Display Limitation with a large number of Backup Sessions/Savesets. Themanagement

server user interface is limited by the number of savesets and/or sessions it may display. In
testing when there is in excess of 100,000 items, the user interface will not display the
information.

l Restore Sessions not Reported for EMC Networker. BackupManager does not currently
support the display of restore sessions for EMC Networker.

l Backup Details are not Gathered fromMulti-homedHosts if CIM Extension IP is Restricted.
The CIM extensions have the capability of being restricted to listening on and using a
particular IP address onmulti-homed systems (hosts with multiple IP addresses). Although
the host information will be returned, backup information will not be sent back to the
management server while the CIM extension is in this type of configuration.

l Status not Displayed in Topology for BackupMaster Server . The Session Status is not
displayed in the BackupManager Topology for the BackupMaster Server Hosts.

l NetBackup Does Not Report Media Information for Disk-based Backups. NetBackup does
not report media information for disk-based backups. Consequently, theMedia Used field is
blank in BackupManager.

l Disk-based Backup Devices are Shown as Physical Tape Libraries in HP Data Protector.
Disk-based backup devices are shown as physical tape libraries in HP Data Protector. In
Veritas NetBackup, only robotic tape library devices are shown; other backup devices
(simple tape drives or disks) are not shown.
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Troubleshooting Installation and
Migration

The following topics provide information on troubleshooting installations and upgrades.

l "Troubleshooting a Failed Installation or Migration" below

l "Importing One orMore Reports" on page 122

l "“The environment variable ‘perl5lib’ is set.” Message" on page 135

l "Perl not Installed on the Linux Computer" on page 1

l "Additional Entries Appear in the Discovery Pages" on page 136

l "Troubleshooting the Oracle Database" on page 136

l "Receiving HTTP ERROR: 503When Accessing theManagement Server" on page 138

l "Web Intelligence Processing Server Does Not Start " on page 139

Troubleshooting a Failed Installation or
Migration

(Windows management servers only) You can quickly gather system information and log files for
troubleshooting by running the srmCapture.cmd program in <installation
directory>/tools. The program provides a date and time-stamped zip file with this information.

The srmCapture.cmd program requires that zip.exe be in the same folder as srmCapture.cmd. If
you aremissing zip.exe, you can find it in the tools directory in both theManagerCDLinux and
ManagerCDWindows directories on the StorageEssentials DVD.

To run the srmCapture.cmd program:

1. Open a command prompt window on theWindows management server, and go to the
<installation directory>/tools directory.

2. Type the srmCapture command. The command has several parameters:

srmCapture [/nowait] [/listmodules] [/?] [/help] [/usage]

n /nowait

Non-interactivemode. The srmCapture command runs without prompting you with the
message "press any key to continue."

n /listmodules

Shows the dll files in use by each process (written to srmListProcesses.txt). If you use the
/listmodules parameter, youmust also include the /nowait parameter.
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n /?, /help or /usage

Provides information on how to use srmCapture.

The following are examples of srmCapture commands:

n srmCapture

n srmCapture /?

n srmCapture /nowait

n srmCapture /nowait /listmodules

The following information is gathered by srmCapture.cmd:

l List of environment variables, look for the srmListEnvVar.txt file.

l Results from running ipconfig /all, look for the srmListIpconfigAll.txt file.

l Results from running netstat -noab, look for the srmListNetstatNoab.txt file.

l Results from running netstat -rte, look for the srmListNetstatRte.txt file.

l Results from running netsh diag show test, look for the
srmListNetshDiagShowTest.txt file.

l Install wizard log files (all files are located in %systemdrive%\srmInstallLogs).

l srmwiz.ini

l Oracle export log file

l File SRM log files

l File SRM configuration files

l Oracle log files

l Zero G registry content

If a message similar to Current location, d:\Tools, is not writable appears, the
current working subdirectory is not writable. The srmCapture.cmd program goes through the
following directories, in order, until it finds one that is writeable:

1. %temp%

2. %tmp%

3. %systemdrive%

Log Files from the Installation and Migration on
Windows

The Install/Migrate wizard generates log files in the C:\srmInstallLogs directory. Log files
provided at the top level of the C:\srmInstallLogs directory are for the current session of the
Install/Migrate wizard or for the last session the Install/Migrate wizard was run. Files from a
previous session are stored in a subdirectory with a date and time stamp.
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Log files are generated by the Install/Migrate wizard. Some log files also provide an <logfilename>_
output.log file. The <logfilename>_output.log file displays information about any errors, and is
generated by the component itself instead of the Install/Migrate wizard.

The log files are zipped into a file in the root of the system drive. The zip file can be sent to support
to help diagnose installation andmigration issues, for example: C:\srmLog02-01-2011-16_
21_49.zip.

The following log files can be found in C:\srmInstallLogs:

l Srm_InstallBaseSoftware_Output.log provides logging information about the installation of
the base version of HP Storage Essentials.

l Srm_DatabaseInstance_Output.log provides information about any errors that occurred during
the creation of the database instance for HP Storage Essentials.

l Srm_CopyCimExtensions_Output.log provides logging information about the copying of the
CIM extensions. This log file is only provided if you select the option to copy the CIM extensions
to themanagement server during the installation or migration.

l Srm_ImportDatabase_Output.log provides logging information about the database import
process when you run the Install/Migrate wizard tomigrate to the latest HP Data Protector
Reporter environment. This log file is provided only if you aremigrating HP Data Protector
Reporter.

l Srm_ExportDatabase_Output.log provides logging information about the database export
process when you run the Install/Migrate wizard to back up the database. The database backup
is required when you aremigrating HP Data Protector Reporter. This log file is provided only if
you aremigrating HP Data Protector Reporter.

l Srm_RestoreConfiguration_Output.log provides logging information about the restore
process when you aremigrating HP Data Protector Reporter.

l backUpConfiguration.log provides the logging information about the back up process that
occurs when you aremigrating HP Storage Essentials.

l Ro_InstallBaseSoftware_Output.log provides logging information about the installation of the
base version of Report Optimizer.

l Ro_InstallROSoftware_Output.log provides logging information about the installation and
migration of Report Optimizer.

l Ro_UpgradeTomcat_Output.log provides logging information about the Tomcat upgrade
process during the installation andmigration of the Report Optimizer.

l Ro_ImportBiarFile_Output.log provides logging information about the import of the BIAR file
during the installation andmigration of the Report Optimizer.

l Ro_ImportPreviousBiarFile_Output.log provides logging information about the import of the
BIAR file when you run the Install/Migrate wizard tomigrate to the new version of the Report
Optimizer.

l Ro_ExportBiarFile_Output.log provides logging information about the export of the BIAR file
when you run the Install/Migrate wizard to export the Report Optimizer configuration.

l Rd_InstallBaseSoftware_Output.log provides logging information about the installation of the
base version of the Report Database.
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l Rd_InstallDatabase_Output.log provides logging information about the creation of the
database instance for the Report Database.

l Rd_Resetpassword_Output.log provides logging information about the password reset
operation for Report Database user. This log file is available only if you have installed Report
Optimizer.

l Oracle_InstallBaseSoftware.log provides logging information about the installation of the base
version of the Oracle database.

l Oracle_InterimPatches.log provides logging information about the installation of the patches
for the Oracle database.

l Wizard.log is themaster log file of the Install/Migrate wizard session. It provides information for
troubleshooting installation of themanagement server and related components.

l WizardSetup.log is the log file of the installation wizard entry point. It provides information for
troubleshooting installation wizard startup issues. The log file without a date and time is the
current log file. This file provides information of the last task that was done in the installation
wizard.

l Srmwiz.ini provides information about the settings for the Install/Migrate wizard, such as the
installation directory for HP Storage Essentials.

Log Files from the Installation on Linux
When an installation is successful, the Install/Migrate wizard zips up the log files and places them
in the Installation_Directory/logs directory. In this instance, Installation_
Directory is the directory where the product was installed.

The name of the zip file has a date stamp InstallWizard_MM_DD_YYYY_HH_MM_SS.zip; for
example, InstallWizard_12_12_2012-01_21_30.zip.

The zip file includes two internal log files created by the installation. These files contain debug
information for internal use only.

l /tmp/InstallSRMTemp/WizardSetup.log

l /tmp/InstallSRMTemp/Wizard.log

The log files are available at the following location:

<Installation_Directory>/logs

Installation Does Not Import the BIAR File
If the Install/Migrate wizard is unable to import the BIAR file, youmust manually import this file.
See the information for your operating system:

"Linux" below

"Windows" on the next page

Linux

To import the BIAR file:
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1. Make sure that the Report Optimizer services, for example SQL Anywhere, Tomcat, and
Bobj120Enterprise are running.

The following is an example of how you would start a service, such as Bobj120Enterprise: 

/etc/init.d/BobjEnterprise120 stop

/etc/init.d/BobjEnterprise120 start

2. Open the ImportBiarFileLinux.properties file in a text editor. The file is located in the
following directory: /opt/HP/ReportOptimizer/

3. Modify the ImportBiarFileLinux.properties file with the password and BIAR file
name, as shown in the example below:
n action=importXML

n importBiarLocation=/opt/SE_Backup/sereporter.biar

n userName=Administrator

n password=Changeme123

n authentication=secEnterprise

n CMS=<Computername>:6400

n includeSecurity=true

n stacktrace=true

Modify the following values as necessary:

n importBiarLocation. Modify the value of this property with the name and location of the
BIAR file. If you are importing BIAR file for Report Optimizer version 9.6.0, specify the path
as /opt/HP/Report Optimizer. If you are importing BIAR file for Report Optimizer
version earlier to 9.6.0, specify the path of the file that you copied in "Step 4a – Copy Back
up Files" (on page 1).

n password. Modify the value of the password.

4. Open command prompt and enter the following command to import the BIAR file:

<RO_install_dir>/ImportBiarFile.sh ImportBiarFileLinux.properties

>> <Report Optimizer install dir>/logs/ImportBiarFile.log

In this instance, <RO_install_dir> is the Report Optimizer installation directory.

Windows

To import your BIAR file:

1. Restart the BOE120SQLAnywhere service.

2. Open the ImportBiarFileWindows.properties file in a text editor. The file is located in
the following directory: C:\HP\ReportOptimizer

3. Modify the ImportBiarFileWindows.properties file with the password and BIAR file
name, as shown in the example below:
n action=importXML

n importBiarLocation=C:\HP\ReportOptimizer\ReportPackage_9_5_0.biar
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n userName=Administrator

n password=Changeme123

n authentication=secEnterprise

n CMS=<Computername>:6400

n includeSecurity=true

n stacktrace=true

Modify the following values as necessary:

n importBiarLocation. Modify the value of this property with the name and location of the
BIAR file.

n password. Modify the value of the password.

4. Make sure the services are running for Report Optimizer. for example SQL Anywhere, Tomcat,
and Bobj120Enterprise.

5. To import the BIAR file, enter the following importbiarfile.sh script on one line at the command
prompt:

<Report Optimizer install dir>\ImportBiarFile.bat >> <Report

Optimizer install dir>\logs\ImportBiarFile.log

In this instance, <Report Optimizer> is the installation directory for Report Optimizer.

Importing One or More Reports
You can import one or more customized reports from one server running Report Optimizer to
another without having to import the entire report set.

"Linux" below

"Windows" on page 127

Linux

With Linux youmust specify which items, such as reports, you want exported out of the BIAR file.

1. Copy the following text and save it to a file named exportBiarFile.properties in the
installation directory, /opt/HP/ReportOptimizer, for example:

# properties file for BO XI R3 Biar Engine # properties used to

export ReportPackage_9_5_0.biar

action=exportXML

exportBiarLocation=/opt/HP/ReportOptimizer/ReportPackage_9_4_0_

HF.biar

userName=Administrator

password=

authentication=secEnterprise

exportDependencies=true
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CMS=<Name of the server running Report Optimizer:6400

includeSecurity=true

stacktrace=true

exportQueriesTotal=8

exportQuery1=select * from CI_INFOOBJECTS WHERE SI_KIND='Folder'

and (SI_NAME='Root Folder' or SI_NAME='Report Pack')

exportQuery4=select * from CI_APPOBJECTS where SI_

KIND='WebIntelligence'

exportQuery5=select * from CI_SYSTEMOBJECTS WHERE SI_

KIND='UserGroup' and SI_NAME='SE Reports'

exportQuery6=select * from CI_SYSTEMOBJECTS WHERE SI_KIND='User'

and SI_NAME='ReportUser'

exportQuery7=select * from CI_SYSTEMOBJECTS WHERE SI_KIND='Folder'

and SI_NAME='Servers'

exportQuery8=select * from CI_SYSTEMOBJECTS WHERE SI_KIND='Folder'

and SI_NAME='Users'

Properties have to bemodified based on your requirements so that you can export them to a
BIAR file. If you do not want to export users/user groups and access rights, you can remove
queries from 5 to 8 and the properties file will resemble the following example:

# properties file for BO XI R3 Biar Engine # properties used to

export ReportPackage_9_5_0.biar

action=exportXML

exportBiarLocation=/opt/HP/ReportOptimizer/ReportPackage_9_4_0_

HF.biar

userName=Administrator

password=

authentication=secEnterprise

exportDependencies=true

CMS=<Name of the server running Report Optimizer:6400

includeSecurity=true

stacktrace=true

exportQueriesTotal=4

exportQuery1=select * from CI_INFOOBJECTS WHERE SI_KIND='Folder'

and (SI_NAME='Root Folder' or SI_NAME='Report Pack')

exportQuery2=select * from CI_INFOOBJECTS WHERE SI_KIND='Webi' and

SI_ANCESTOR=9864
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exportQuery3=select * from CI_APPOBJECTS WHERE SI_KIND='Universe'

and SI_NAME='Report Connector'

exportQuery4=select * from CI_APPOBJECTS where SI_

KIND='WebIntelligence'

If you want to export only a report, the file would bemodified as follows:

# properties file for BO XI R3 Biar Engine # properties used to

export ReportPackage_9_5_0.biar

action=exportXML

exportBiarLocation=/opt/HP/ReportOptimizer/ReportPackage_9_4_0_

HF.biar

userName=Administrator

password=

authentication=secEnterprise

exportDependencies=true

CMS=<Name of the server running Report Optimizer:6400

includeSecurity=true

stacktrace=true

exportQueriesTotal=1

exportQuery1=select * from CI_INFOOBJECTS WHERE SI_KIND='Webi' and

SI_NAME=’Host Summary’

In this example, the file that will be exported is the Host Summary report, as referenced in the
SI_Name value.

If you want to take backup of a report and universe

# properties file for BO XI R3 Biar Engine # properties used to

export ReportPackage_9_5_0.biar

action=exportXML

exportBiarLocation=/opt/HP/ReportOptimizer/ReportPackage_9_4_0_

HF.biar

userName=Administrator

password=

authentication=secEnterprise

exportDependencies=true

CMS=<Name of the server running Report Optimizer:6400

includeSecurity=true

stacktrace=true

exportQueriesTotal=2
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exportQuery1=select * from CI_INFOOBJECTS WHERE SI_KIND='Webi' and

SI_NAME=’Host Summary’

exportQuery3=select * from CI_APPOBJECTS WHERE SI_KIND='Universe'

and SI_NAME='Report Connector'

2. Change the following properties in the exportBiarFile.properties file created in the
previous step:

n exportBiarLocation - Make sure the property points to the path for the BIAR file you want to
export, for example /opt/HP/ReportOptimizer/ReportPackage_9_4_0_
HF.biar.

n username - Do not change the value of the userName property.

n password - The password for accessing Report Optimizer.

n CMS - Provide the IP address or DNS name of the server running Report Optimizer

n SI_ANCESTOR - Change the default value of 9864 to the ID used by your instance of
ReportOptimizer. You can obtain your ID from the Report Pack folder properties page.

To access the properties page:

a. Click Document list in Report Optimizer (Infoview).

b. Expand Public Folders.

c. Select the Report Pack folder.

d. Right-click Properties. The ID for your instance of Report Optimizer is circled in the
following screen. You can copy and paste this ID as the SI_ANCESTER value to the
exportBiarFile.properties file
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3. Open a command line window and go to the installation directory of Report Optimizer,
/opt/HP/ReportOptimizer, for example.

4. Run biarengine.jar by entering the following command at the command prompt:

<Install dir>/jre/bin/java –jar

<installdir>/bobje/java/lib/biarengine.jar

<installdir>/exportBiarFile.properties

This command should be entered on one line.

In this instance replace <Install dir> with the name of the installation directory. The
default directory is the following: /opt/HP/ReportOptimizer. The command prompt is not
listed in the previous command.

5. To import the BIAR file:

a. Make sure that the Report Optimizer services, for example SQL Anywhere, Tomcat, and
Bobj120Enterprise are running.

The following is an example of how you would start a service, such as Bobj120Enterprise: 

/etc/init.d/BobjEnterprise120 stop

/etc/init.d/BobjEnterprise120 start

b. Open the ImportBiarFileLinux.properties file in a text editor. The file is located
in the following directory: /opt/HP/ReportOptimizer/

c. Modify the ImportBiarFileLinux.properties file with the password and BIAR file
name, as shown in the example below:
o action=importXML

o importBiarLocation=/opt/SE_Backup/sereporter.biar

o userName=Administrator

o password=Changeme123

o authentication=secEnterprise

o CMS=<Computername>:6400

o includeSecurity=true

o stacktrace=true

Modify the following values as necessary:

o importBiarLocation. Modify the value of this property with the name and location
of the BIAR file. If you are importing BIAR file for Report Optimizer version 9.6.0,
specify the path as /opt/HP/Report Optimizer. If you are importing BIAR file for
Report Optimizer version earlier to 9.6.0, specify the path of the file that you copied in
"Step 4a – Copy Back up Files" (on page 1).

o password. Modify the value of the password.

d. Open command prompt and enter the following command to import the BIAR file:
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<RO_install_dir>/ImportBiarFile.sh

ImportBiarFileLinux.properties >> <Report Optimizer install

dir>/logs/ImportBiarFile.log

In this instance, <RO_install_dir> is the Report Optimizer installation directory.

Windows

To import one or more reports:

1. Restart the BOE120SQLAnywhere service.

2. On the Report Optimizer server, select Start Menu > Programs > BusinessObjects XI
Release 3.1 > BusinessObjects Enterprise > Import Wizard. TheWelcome to the Import
Wizard window opens.

3. Click Next. The Source Environment window opens.

4. Select Business Intelligence Archive Resource (BIAR) File from the Source drop-down
menu. Click the ... button, browse to the directory where the BIAR file is located,
/HP/ReportOptimizer/ReportPackage_9_5_0.biar.

5. Click Open

6. Click Next. The Destination Environment window opens.
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7. Make sure that the name of your Report Optimizer server is entered in the CMS Name box.
Enter the Report Optimizer user name and password. Enter Administrator for the user name
and the password for the Administrator user. The default password for the Administrator
account is Changeme123.

8. Click Next. It could take several minutes for the Select Objects to Import window to open.

9. In the Select Objects to Import window, click theClear All All button.

10. Select the Import application folders and objects option, as shown in the following image.
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11. Click Next.

12. When you are shown the A Note on Importing Universes window, click Next.
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13. Do not select any options in the Custom Access Window, as shown in the following image.

14. Click Next.
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15. Select the customized report that you want to merge into themain BIAR file under “Report
Pack”.

16. Click Next.

17. Do not select any options in the Select Application Folders andObjects window.
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18. Click Next. Do not select any options in the Import Options for Publications window.
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19. Click Next. Then, click Next again after viewing the note on importing reports.
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20. Click Finish to begin the import process.
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“The environment variable ‘perl5lib’ is set.”
Message

(Windows Only) If the perl5lib environment variable is set, the installation/migration fails with the
followingmessage:

Perl5lib Environment Variable Message

This variable could have been set by another application. The environment variable could also have
been set if your upgrade of Oracle was suddenly stopped; for example, as a result of a power
outage. Youmust remove the perl5lib environment variable before you can run the Install/Migrate
wizard again. For information about removing environment variables, refer to the documentation for
theWindows operating system.
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Additional Entries Appear in the Discovery
Pages

Youmight see additional entries in the Discovery pages after an upgrade.

For example, assume you have a Brocade SMI Agent running on 192.168.1.2 at 8959 and there are
three switches added to this SMI-A, as shown in the following figure. In this example, two entries
are created for 192.168.1.2 and six entries are created for three switches: two for each switch.

HP Storage Essentials places a checkmark next to items added in Discovery Step 1 but cannot
obtain additional information in Discovery Step 2 or Discovery Step 3.

All entries with a checkmark can be deleted. In this example, seven entries can be deleted.

Duplicate Entries on the Discovery Pages

Troubleshooting the Oracle Database
When installing or migrating anOracle database, be aware of these known considerations:

l "UseOnly the InstallationWizard (or UNIX Scripts) to Install/UpgradeOracle" on the next page

l "Existing Oracle Database Is Detected" on the next page

l "Unable to Install the Oracle Database on Linux" on the next page
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Use Only the Installation Wizard (or UNIX Scripts)
to Install/Upgrade Oracle

With this release of the product, the Oracle database is automatically installed using the new
InstallationWizard (or UNIX scripts) developed to install themanagement server along with the
Oracle database used by themanagement server. Installing Oracle separately is no longer
recommended.

Do not install the Oracle database separately, themanagement server InstallationWizard (or UNIX
scripts) automatically configures the Oracle database for use with themanagement server. If you
install the Oracle database separately, the database will not meet the configuration settings
required by themanagement server.

Existing Oracle Database Is Detected
(Linux installations Only) If the UNIX installation scripts detect an existing Oracle database, the
followingmessage is displayed: “Existing Oracle Database is Detected.”

Unable to Install the Oracle Database on Linux
The installation of the Oracle database on Linux does not work when the dba group exists in an
external database, such as LDAP. TheOracle Universal Installer attempts to verify that the oracle
user belongs to the dba group. This verification fails since the oracle user’s group is not listed in
/etc/group.

The following error is logged in the Oracle_InstallBaseSoftware_Output.log file:

ERROR: Oracle Installation probably failed - Timeout error.

Please check the log files under /opt/oracle/oraInventory/logs.

The /opt/oracle/oraInventory/logs directory contains a file, such as installActions
{datetimestamp}.log.

The following error also appears in the installActions{datetimestamp}.log file:

SEVERE: [FATAL] [INS-35341] User is not a member of the following

chosen OS groups: [dba, dba]

CAUSE: User is not a member of one or more of the chosen OS groups.

ACTION: Please choose OS groups of which user is a member.

To resolve this issue, do the following:

1. Disable LDAP authentication on system when installing HP Storage Essentials.

2. Ensure that Linux group lookup is performed with files before ldap. Find the group and
password entries in the /etc/nsswitch.conf file and ensure ldap is entered as a lookup
method after files. The following is an example of the group and passwd entry:
n group:      files ldap

n passwd:     files ldap

3. Enable LDAP authentication after installing HP Storage Essentials.
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Receiving HTTP ERROR: 503 When Accessing
the Management Server

If you receive amessage resembling the following when you try to access themanagement server,
make sure your database for themanagement server is running. If it is not, start the database.

Receiving HTTP ERROR: 503 javax.ejb.EJBException: null;

Windows
In the Services window, make sure the OracleOraHome11gR2TNSListener service has started and
is set to automatic. For information on how to access the Services window, see theWindows
documentation.

If the OracleOraHome11gR2TNSListener service has not started, but the AppStorManager service
has started, start the OracleOraHome11gR2TNSListener service, and then restart
AppStorManager.

UNIX
To verify that the Oracle service started, enter the following at the command prompt:

# ps -ef | grep ora

If the service started, output similar to the following is displayed:

/opt/oracle/product/9.2.0.1.0/bin/tnslsnr LISTENER -inherit

 ./appstormservice /opt/productname/ManagerData/conf/unix-wrapper.

  oracle 356 1 0 Jul 30 ? 0:01 ora_pmon_APPIQ

  oracle 358 1 0 Jul 30 ? 0:26 ora_dbw0_APPIQ

  oracle 360 1 0 Jul 30 ? 1:13 ora_lgwr_APPIQ

  oracle 362 1 0 Jul 30 ? 0:39 ora_ckpt_APPIQ

  oracle 364 1 0 Jul 30 ? 0:10 ora_smon_APPIQ

  oracle 366 1 0 Jul 30 ? 0:00 ora_reco_APPIQ

  oracle 368 1 0 Jul 30 ?

To start the service for Oracle, enter the following at the command prompt:

# /etc/rc3.d/S98dbora start

To stop the service for Oracle, enter the following at the command prompt:

# /etc/rc3.d/S98dbora stop

If you are starting the services manually, start the Oracle service before the service for the
management server.
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Web Intelligence Processing Server Does Not
Start

(Report Optimizer on Linux) If theWeb Intelligence Processing Server does not start or you are
shown the error message "Cannot initialize Report Engine server (RWI: 00226) (Error: INF)" when
you try to run a report, restart Report Optimizer by entering following commands:

1. To stop Report Optimizer enter the following command:

/etc/init.d/BobjEnterprise120 stop

2. To start Report Optimizer enter the following command:

/etc/init.d/BobjEnterprise120 start

HP Data Protector Reporter (9.6.0)Page 139 of 143



Quick Start Guide
Chapter 6: Troubleshooting Installation andMigration

HP Data Protector Reporter (9.6.0)Page 140 of 143



We appreciate your feedback!
If an email client is configured on this system, by default an email window opens when you click
here.

If no email client is available, copy the information below to a new message in a webmail client,
and then send this message to se.help.feedback@hp.com.

Product name and version:HP Data Protector Reporter, 9.6.0

Document title:Quick Start Guide

Feedback:

HP Data Protector Reporter (9.6.0)Page 141 of 143

Quick Start Guide
Weappreciate your feedback!

mailto:se.help.feedback@hp.com?subject=Feedback on the HP Storage Essentials (9.60) documentation


HP Data Protector Reporter (9.6.0)Page 142 of 143

Quick Start Guide
Weappreciate your feedback!




	Quick Start Guide
	Contents
	About This Guide
	Obtaining HP Data Protector Reporter
	Installing HP Data Protector Reporter on Microsoft Windows
	Pre-installation Checklist
	Installation and Migration Requirements
	Ports Used by the Product

	Turn Off Internet Information Services (IIS) and Third-Party Web Servers
	Disable User Access Control on Windows
	Verify Networking
	Install a Supported Browser

	Installing the Product
	Windows Installation Checklist
	Step 1 – Read the Release Notes and the Support Matrix
	Step 2 – Log On to the Windows Server
	Step 3 – Open Several Ports (Windows 2008 R2 Only)
	Step 4 – Start the HP Storage Essentials for Windows Installation Wizard
	Step 5 – Obtain a License Key
	Step 6 – Check for the Latest Service Pack

	Removing the Product
	Log Files from the Installation and Migration on Windows
	About This Guide

	Installing HP Data Protector Reporter on Linux
	Pre-installation Checklist
	Ports Used by the Product
	Prerequisite RPMs
	Prerequisite RPMs for Database Admin Utility
	Prerequisite RPMs for Oracle
	Prerequisite RPMs for Report Optimizer

	Software Dependencies
	Verify Network Settings

	Linux Installation Checklist
	Step 1 – Read the Release Notes and the Support Matrix
	Step 2 – Install the Management Server
	Accessing the Linux Host

	Step 3 – Verify that Processes Can Start
	Step 4 – Obtain a License Key
	Step 5 – Verify Your Connection to the Management Server
	Step 6 – Check for the Latest Service Pack
	Step 7 – Install the Java Plug-in on a Linux Client
	Linux 32-bit Clients
	Linux 64-bit Clients

	Log Files from the Installation on Linux
	Removing HP Data Protector Reporter

	Required Configuration Steps after Installing Reporter
	Changing the Passwords for Report Optimizer Accounts
	Changing the Password for the Administrator Account
	Changing the Password for SQL Anywhere User

	Configuring the Report Database to Point to the Management Server
	Configuring a Global Report Database
	Accessing the Central Management Console for Report Optimizer
	Adding the Report Optimizer Server as a Trusted Site
	Installing a Named User Permanent License Key
	Setting the Report Parameters in HP Storage Essentials
	Modifying the Server Session Timeout Value
	Configuring Drill-Down Options
	Disabling Browser Access to Desktop Intelligence
	Adding the Report Designers Group
	Assigning Report Designing Privileges to Report Designers
	Best Practices

	Adding New Users to Report Optimizer
	Best Practices

	Changing the Server Intelligence Agent’s User Account (for Monitoring Remotel...
	Configuring Active Directory (AD) Authentication
	Create a Service Account
	Register an SPN Account
	Grant Rights to Service Account
	(Optional) Set Delegation Option
	Assign Account to Server Intelligence Agent
	Create WINNT Directory
	Set File Locations in Tomcat
	Configure Active Directory Plug-In in RO
	Restart Tomcat

	Scheduling Reports Based on File Based Events
	Setting Up an Email Server
	Best Practices

	Tuning the Report Optimizer Server
	Configuring a Set of User Groups as Read-Only Users
	Disabling Servers that are Not Required
	Increasing the Memory Heap Size Value
	Creating a Server Group
	Adding a Folder for User-Created Custom Reports
	Best Practices

	Deleting Duplicate Folders


	Required Configuration Steps for HP Data Protector Reporter
	Prerequisites for Agentless Discovery of  Data Protector
	Step 1 – Install the Data Protector Client
	Linux Installation Steps
	Windows Installation Steps

	Step 2  – Create a User Group for HP Data Protector Reporter
	Step 3 – Start the AppStorManager Service with the Context of Local Administr...
	Step 4 – Create a User within the DPREPORTER User Group
	Step 5 – Install the Data Protector Patch

	Launching the Backup Host Configuration and Discovery Wizard
	Step 1 – Discover Backup Host Address
	Step 2 – Set Retention Value for Backup Session Data
	Step 3 – Set Up Email Notifications
	Step 4 – Configure Report Optimizer Settings


	Backup Manager
	About   Backup Manager
	Requirements for Backup Manager
	Determining if You Have Enough Media to Run a Backup

	Viewing Running Sessions
	Retrieving Restore Sessions from Data Protector Cell Manager
	Determining Last Successful Backup
	Viewing the Summary Backup Charts
	Viewing Backup Results for a Backup Manager Host
	Viewing Backup Results for a Client
	Viewing Backup Information for a Client

	About the User Interface for Backup Manager
	About the Topology Icons in Backup Manager
	About the Toolbars in Backup Manager
	Main Toolbar for Backup Manager
	Toolbar for Charts

	Changing the Topology Settings
	Right-Click Menu Options on the Topology Tab

	About the Summary Backup Charts
	About the Tabs in the Topology Lower Pane
	Sorting Information in the Lower Pane
	Modifying Summary Backup Charts
	Viewing Charts for a Backup Manager Host
	Printing Summary Charts
	Changing Collection Times for Media and Session Collectors
	Changing the Frequency of Collection Times
	Stopping Background Collections when a CIM Extension Starts
	Changing the Number of Days Session is Stored in the Cache Database

	Known Issues

	Troubleshooting Installation and Migration
	Troubleshooting a Failed Installation or Migration
	Log Files from the Installation and Migration on Windows
	Log Files from the Installation on Linux

	Installation Does Not Import the BIAR File
	Importing One or More Reports
	“The environment variable ‘perl5lib’ is set.” Message
	Additional Entries Appear in the Discovery Pages
	Troubleshooting the Oracle Database
	Use Only the Installation Wizard (or UNIX Scripts) to Install/Upgrade Oracle
	Existing Oracle Database Is Detected
	Unable to Install the Oracle Database on Linux

	Receiving HTTP ERROR: 503 When Accessing the Management Server
	Windows
	UNIX

	Web Intelligence Processing Server Does Not Start

	We appreciate your feedback!

